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Preface and Legal Notices

This is the User Manual for the MySQL Workbench.

For license information, see the Legal Notices. This product may contain third-party code. For license
information on third-party code, see Appendix A, Third Party Licenses.

Legal Notices
Copyright © 2006, 2013, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are provided under a license agreement containing restrictions
on use and disclosure and are protected by intellectual property laws. Except as expressly permitted

in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast,
modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any
means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for
interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free.
If you find any errors, please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it on
behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and

technical data delivered to U.S. Government customers are "commercial computer software" or
"commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific
supplemental regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be
subject to the restrictions and license terms set forth in the applicable Government contract, and, to the
extent applicable by the terms of the Government contract, the additional rights set forth in FAR 52.227-19,
Commercial Computer Software License (December 2007). Oracle USA, Inc., 500 Oracle Parkway,
Redwood City, CA 94065.

This software is developed for general use in a variety of information management applications. It is nhot
developed or intended for use in any inherently dangerous applications, including applications which
may create a risk of personal injury. If you use this software in dangerous applications, then you shall be
responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure the safe
use of this software. Oracle Corporation and its affiliates disclaim any liability for any damages caused by
use of this software in dangerous applications.

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. MySQL is a trademark of Oracle
Corporation and/or its affiliates, and shall not be used without Oracle's express written authorization. Other
names may be trademarks of their respective owners.

This software and documentation may provide access to or information on content, products, and services
from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all
warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and
its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of
third-party content, products, or services.

This document in any form, software or printed matter, contains proprietary information that is the exclusive
property of Oracle. Your access to and use of this material is subject to the terms and conditions of your
Oracle Software License and Service Agreement, which has been executed and with which you agree

to comply. This document and information contained herein may not be disclosed, copied, reproduced,

or distributed to anyone outside Oracle without prior written consent of Oracle or as specifically provided
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below. This document is not part of your license agreement nor can it be incorporated into any contractual
agreement with Oracle or its subsidiaries or affiliates.

This documentation is NOT distributed under a GPL license. Use of this documentation is subject to the
following terms:

You may create a printed copy of this documentation solely for your own personal use. Conversion to other
formats is allowed as long as the actual content is not altered or edited in any way. You shall not publish

or distribute this documentation in any form or on any media, except if you distribute the documentation in
a manner similar to how Oracle disseminates it (that is, electronically for download on a Web site with the
software) or on a CD-ROM or similar medium, provided however that the documentation is disseminated
together with the software on the same medium. Any other use, such as any dissemination of printed
copies or use of this documentation, in whole or in part, in another publication, requires the prior written
consent from an authorized representative of Oracle. Oracle and/or its affiliates reserve any and all rights
to this documentation not expressly granted above.

For more information on the terms of this license, or for details on how the MySQL documentation is built
and produced, please visit MySQL Contact & Questions.

For help with using MySQL, please visit either the MySQL Forums or MySQL Mailing Lists where you can
discuss your issues with other MySQL users.

For additional documentation on MySQL products, including translations of the documentation into other
languages, and downloadable versions in variety of formats, including HTML and PDF formats, see the
MySQL Documentation Library.
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Chapter 1. MySQL Workbench Introduction

MySQL Workbench provides a graphical tool for working with MySQL Servers and databases. MySQL
Workbench fully supports MySQL Server versions 5.1 and above. It is also compatible with MySQL Server
5.0, but not every feature of 5.0 may be supported. It does not support MySQL Server versions 4.x.

MySQL Workbench provides three main areas of functionality:

e SQL Development: Enables you to create and manage connections to database servers. As well as
enabling you to configure connection parameters, MySQL Workbench provides the capability to execute
SQL queries on the database connections using the built-in SQL Editor. This functionality replaces that
previously provided by the Query Browser standalone application.

» Data Modeling: Enables you to create models of your database schema graphically, reverse and
forward engineer between a schema and a live database, and edit all aspects of your database using
the comprehensive Table Editor. The Table Editor provides easy-to-use facilities for editing Tables,
Columns, Indexes, Triggers, Partitioning, Options, Inserts and Privileges, Routines and Views.

» Server Administration: Enables you to create and administer server instances.

MySQL Workbench is available in two editions, the Community Edition and the Standard Edition. The
Community Edition is available free of charge. The Standard Edition provides additional Enterprise
features, such as database documentation generation, at low cost.

For release notes detailing changes made in each release of MySQL Workbench, see Appendix C, MySQL
Workbench and Utilities Change History.







Chapter 2. MySQL Workbench Editions

The Community Edition (OSS)

The Community Edition is the foundation of all MySQL Workbench editions—versions that are currently
available or those that will become available in the future. All editions of MySQL Workbench are based on
the Community Edition and all future improvements to the base framework and feature set will be included
in this version. The Community Edition is a full feature product that puts a powerful database management
tool into the hands of the MySQL community.

The Standard Edition

The Standard Edition is a commercial extension that builds on top of the OSS Edition and adds modules
and plugins, enabling an optimized work flow. The highlights of this edition are:

MySQL Specific Schema Validation

Model Validation

General Schema Validation

» DBDoc

DBDoc provides the following features:

» Document complex database schemata

» Document all SQL object types

« Document output available in different file formats

A comparison of edition features can be found at MySQL Workbench Developer Central.
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MySQL Workbench is available for the following platforms:
* Windows

 Linux

* Mac OS X

Binary distributions of MySQL Workbench are available for the preceding platforms. Source code
distributions are also available as at ar . gz package or an RPM package.

The following sections explain the installation process for each of these platforms.

3.1. Hardware Requirements

MySQL Workbench requires a system that runs smoothly. The minimum hardware requirements are:
» CPU: 32-hit or 64-bit

» Cores: Single (Single Core 3GHz or higher, Dual Core 2GHz or higher recommended)

RAM: 4 GB (6 GB or higher recommended)

Graphic Accelerators: nVidia or ATl with support of OpenGL 2 or higher

» Display Resolution: 1280x1024 minimum (1920x%1200 or higher recommended)

3.2. Software Requirements
The following operating systems are officially supported:
* Apple Mac OS X v10.6.1+ (32-hit/64-bit)
» Fedora 15 (32-hit/64-bit)
* Microsoft Windows 7 (32-bit/64-bit)

e Oracle Linux 6 (32-bit/64-bit)
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« Ubuntu 10.04 LTS (32-bit/64-bit)
« Ubuntu 11.04 (32-bit/64-bit)

MySQL Workbench also has the following general requirements:

Note
@ On startup, the application checks the OpenGL version and chooses between
software and hardware rendering. To determine which rendering method is being
used, open the Help menu and choose the System Info item.
Requirements for Linux:

» The requirements for Linux are embedded within their respective packages. Use the platform specific
tool (for example, yum or apt) to install the package and their dependencies.

Requirements for Microsoft Windows:
» Microsoft .NET 4.0 Framework
e Microsoft Visual C++ 2010 Redistributable Package (x86)

Note

S For convenience, the Windows libraries are available as the download
“Dependencies for Compiling in Windows”.

3.3. Starting MySQL Workbench

The procedure for launching MySQL Workbench depends on the platform. Generally, there are two ways
to launch MySQL Workbench: either from the command line or from the graphical user interface of the host
operating system. Using the command-line launching facility is useful when you want to customize some
aspects of the way MySQL Workbench operates. The following sections describe how to launch MySQL
Workbench for each of the supported platforms.

In addition to platform-specific command-line options, MySQL Workbench has the following command-line
options:

* --lo0g-1evel I evel : Controls the verbosity level for logging output from Workbench.

With increasingly levels of verbosity, the valid values for | evel are: error, warning, info, debug1,
debug2, and debug3.

The location of the generated log files are as follows: Linux: ~/ . mysql / wor kbench/ | og/ wb. | og,
Mac: ~/ Li brary/ Appl i cati on Support/Wrkbench/ | og/wb. | og, and on Windows: C: \ User s
\[your wuser id]\AppData\ Roani ng\ MySQ.\ Wor kbench\ wh. | og

e --adm n instance: Load the server instance specified.
e --query connecti on: Load the connection specified.

» --nodel nodel fil e: Load the model specified.

--script script: Runthe script specified.

e --run code: Run the code snippet specified.
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e --quit-when-done: Quits MySQL Workbench after - - scri pt or - - r un finishes.

3.3.1. Installing MySQL Workbench on Windows

MySQL Workbench for Windows can be installed using the Windows Installer package or installed
manually from a Zip file.

Important

Administrator or Power User privileges. If you are using the Zip file without an

A Installing MySQL Workbench using the Installer package requires either
installer, you do not need Administrator or Power User privileges.

Installing MySQL Workbench Using the Installer Package

MySQL Workbench can be installed using the Windows Installer (. nsi ) installation package. The MSI
package bears the name nysql - wor kbench- ver si on-w n32. nsi , where ver si on indicates the
MySQL Workbench version number.

Improving the MySQL Installation Wizard depends on the support and feedback of users. If you find that
the MySQL Installation Wizard lacks some feature important to you, or if you discover a bug, please report
it in our bugs database. Select the Report a Bug item from the Help menu.

1. To install MySQL Workbench, right-click the MSI file and select the Install item from the pop-up menu,
or double-click the file.

2. Inthe Setup Type window you may choose a Conpl et e or Cust ominstallation. To use all features of
MySQL Workbench choose the Conpl et e option.

3. Unless you choose otherwise, MySQL Workbench is installed in C: \ %°PROGRAMFI LES% My SQL
\ MySQL Wor kbench 5.1 edition_type\, where %PROGRAMFI LES%is the default directory
for programs for your locale. The %°ROCGRANFI LES%directory may be C. \ Program Fi | es or C:
\ progr ame.

Installing from the Zip File

If you have problems running the Installer package, an alternative is to install from a Zip file without an
installer. That file is called nysqgl - wor kbench- ver si on-w n32. zi p.

To install using the Zip file, download the Zip file to a convenient location and decompress the file using a
Zip utility. You can place the resulting directory anywhere on you system. You need not install or configure
the application before using it. You may want to create a shortcut on your desktop or the quick launch bar.

3.3.2. Launching MySQL Workbench on Windows
To start MySQL Workbench on Windows, select Start, Programs, MySQL, then select MySQL Workbench.

Alternatively, start MySQL Workbench from the command line. To view the available command-line
options, issue the command My SQLWor kbench -hel p | nor e from the MySQL Workbench installation
directory. You will see the following output:

MySQL Wor kbench 5.2.34 SE. (C) 2006-2011 by Oracle Corporation.
Al rights reserved.

Usage: MySQLWor kbench [options] [nodel file]

Opt i ons
-admn instance .... Open an admn tab to the naned server instance at startup
-open filename ..... Open the given filenane at startup
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-query server ...... Open a DB query tab to the naned server connection at startup
-run script ........ Executes the gi ven Workbench script at startup

-run- pyt hon script . Executes the given Wrkbench Python script at startup
-run-lua script .... Executes the given Wrkbench Lua script at startup

-script scriptfile . Executes the given Wrkbench script file at startup
-quit-when-done .... Quits Wrkbench once the given script finishes executing
-swendering ....... Force the canvas to use software rendering instead of OpenGL
-nologo ............ Do not display the splash screen

-log ... Instruction to save nessages (other debug info) to file
-verbose (-v) ...... Print verbose output in the GRT Shell

-version ........... Print the version infornmation

-grtversion ........ Print the GRT version information

-help (-h) ......... Print this output

The MySQL Workbench help output includes a version number, a usage message, and the option
descriptions. Use the - swr ender i ng option if your video card does not support OpenGL 1.5. The -
ver si on option can be used to display the MySQL Workbench version number. The - grt ver si on
can be used to display the GRT (Generic RunTime) shell version number. The other options are self-
explanatory.

to a console window, be sure that you pipe the output through the nor e command.

Note
@ When using the - hel p and - ver si on, command-line options that display output
Otherwise, nothing will be displayed.

3.3.3. Uninstalling MySQL Workbench on Windows

The method for uninstalling MySQL Workbench depends on how you installed MySQL Workbench in the
first place.

Removing MySQL Workbench After Installation Using the Installer Package

1. To uninstall MySQL Workbench, open the Control Panel and Choose Add or Remove Programs.
Find the MySQL Workbench entry and choose the Remove button. This will remove MySQL
Workbench.

2. Any modules added to the C: \ %°ROGRAMFI LES% MySQL\ MySQL Wor kbench ver si on\ nodul es
directory will not be deleted.

Note

@ If you installed MySQL Workbench using the Installer package, it is not possible to
remove MySQL Workbench from the command line. Although you can manually
remove some of the components, there is no command-line option for removing
MySQL Workbench.

Removing the MySQL Workbench directory manually will not remove all the files
belonging to MySQL Workbench.

Removing MySQL Workbench After Installation from a Zip File

To remove MySQL Workbench, just delete the MySQL Workbench directory.

to keep them, make sure you copy those modules to a different directory before

Note
@ If you installed any additional modules within the nodul es directory and you want
deleting the MySQL Workbench directory.
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3.3.4. Installing MySQL Workbench on Linux

There are binary distributions of MySQL Workbench available for several variants of Linux, including
Fedora, Oracle Linux, and Ubuntu.

In addition to the binary distributions, it is also possible to download the MySQL Workbench source code
asatar. gz or RPM package.

Check the MySQL Workbench download page for the latest packages.
The procedure for installing on Linux depends on which Linux distribution you are using.
Installing DEB packages

On Ubuntu, and other systems that use the Debian package scheme, you can install MySQL Workbench
using a command such as:

shel | > sudo dpkg -i package. deb

package. deb is the MySQL Workbench package name; for example, nysql - wor kbench-
oss-version_i 386. deb, where ver si on is the MySQL Workbench version number.

you already have installed. Install the required libraries and then install the MySQL

Note

@ ‘ You may be warned that certain libraries are not available, depending on what
Workbench package again.

Installing RPM packages

On Red Hat-based systems, and other systems that use the RPM package format, MySQL Workbench can
be installed by a command such as:

shel | > sudo rpm -i package.rpm

package. r pmis the MySQL Workbench package name; for example, nysql - wor kbench-
oss-version-1fc10. x86_64. r pm where ver si on is the MySQL Workbench version number.

3.3.5. Launching MySQL Workbench on Linux

After MySQL Workbench has been installed, it can be launched by selecting Applications, Programming,
MySQL Workbench from the main menu.

MySQL Workbench can also be launched from the command line on Linux. Type the command:

shel | > /usr/bi n/ nmysqgl - wor kbench --hel p

This will display the available command-line options:

nmysql - wor kbench [ <options>] [<nodel file>]

Opt i ons
--force-swrender Force Xlib rendering
--force-opengl -render Force OpenGL rendering
--help, -h Show conmand |ine options and exit

3.3.6. Uninstalling MySQL Workbench on Linux

The procedure for uninstalling MySQL Workbench on Linux depends on the package you are using.

Uninstalling DEB packages
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To uninstall a Debian package, use this command:

shel | > sudo dpkg -r mysql - wor kbench- oss

This command does not remove the configuration files. If you wish to also remove the configuration files,
use this command:

shel | > sudo dpkg --purge nysql -wor kbench- oss
Uninstalling RPM packages
To uninstall an RPM package, use this command:

shel | > sudo rpm -e nysql - wor kbench- oss

This command does not remove the configuration files.

3.3.7. Installing MySQL Workbench on Mac OS X

MySQL Workbench for Mac OS X is distributed as a DMG file. The file is named nysql - wor kbench-
0ss-version-o0sx10. 5-i 686. dng, where ver si on is the MySQL Workbench version.

To install MySQL Workbench on Mac OS X, download the file. Double-click the downloaded file. You will
be presented with the installation window.

Figure 3.1. MySQL Workbench Mac OS X Installation Window

OO0 MySQL Waorkbench =

2 items, 5.6 MB available

Mgsé :Workbench

Visual Database Design For Professionals

o
Z ot

A
MySQLWorkbench Applications

To install the applications drag the MySQL Workbench icon to your Applications folder.
You may then “Eject”™ and throw away this disk image

_ MySQL Workbench 4

Drag the MySQL Workbench icon onto the Applications icon as instructed. MySQL Workbench is now
installed.

You can now launch MySQL Workbench from the Applications folder.

3.3.8. Launching MySQL Workbench on Mac OS X

To launch MySQL Workbench on Mac OS X, open the Applications folder in the Finder, then double-click
MySQL Workbench.

10
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It is also possible to start MySQL Workbench from the command line:

shel | > open MySQ.Wor kbench. app nodel _file

A model file must be specified.

3.3.9. Uninstalling MySQL Workbench on Mac OS X

To uninstall MySQL Workbench for Mac OS X, locate MySQL Workbench in the Applications folder, right-
click, and select Move to Trash.

11
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Chapter 4. Getting Started Tutorial
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This tutorial provides a quick hands-on introduction to using MySQL Workbench for beginners. If you have
used MySQL Workbench before you can safely skip this tutorial.

This tutorial uses a locally installed MySQL Server. If you only have access to a remote MySQL server,
you must enter appropriate connection parameters as necessary. This tutorial requires MySQL Workbench
5.2.16 or above. It is assumed that you have a basic understanding of MySQL concepts. This tutorial
demonstrates the procedures on Microsoft Windows, but they are the same for all supported platforms.

4.1. Administering a MySQL Server

In this section, you will use MySQL Workbench to carry out administrative functions, such as starting and
stopping the server.

1. Launch MySQL Workbench. You will be presented with the Home window.

13
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2.

3.

Figure 4.1. Getting Started Tutorial - Home Window

To administer your MySQL Server, you must first create a Server Instance. The instance contains
information about the target server, including how to connect to it. From the MySQL Workbench
Home window, click New Server Instance. The Create New Server Instance Profile wizard will be

displayed.

In this tutorial, you will connect to a locally installed server, so click Next.

MySQL Warkbench =lE s
File Edit View Database Plugins Scripting Community Help
N
Workbench Central v
m Welcome to MySQL Workbench
e, % What's New in This Release?
Workbench Read about all changes in this MySQL Workbench release. MySQLDoc  MySQLBug  Workbench  PlanetMySQL  Workbench
Library Reporter Team Blog Farums
Workspace
SQL Development Data Modeling Server Administration
Connect to existing databases and run //A Create and manage models, forward & Configure your database server, setup
SQL Queries, SQL scripts, edit data and reverse engineer, compare and user accounts, browse status variables
manage database objects. synchronize schemas, report. and server logs.
7 Open Connection to Start Querying D.\ 0Open Existing EER Model » Server Administration
. kel 1]
ﬂ‘u New Connection 5 New Server Instance
E@ Edit Table Data %, Create New EER Model @fﬁ Manage Import | Export
@ =
Eﬁ Edit SQL Script » Create EER Model From Existing Database ” Manage Security
IE -
P Manage Connections [ Create EER Model From SQL Script Manage Server Instances
e o =
|8 |
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Figure 4.2. Getting Started Tutorial - Specify Host Machine

Create New Server Instance Profile [x]

Specify Host Machine

Specify the Host Machine the Database Server is running on

eckion
3 Connect] This wizard will guide wau through the creation of a Server Prafile o manage a MwSQL server, To Fully suppart
rnanagernent of a remote MySQL server, an SSH daerman must be running on the karget machine. Alternatively, if
Management an: you ate going ko manage & Windows server from a Windows computer, vou can also use native Windows
ranagernent tools, Rerote management is used to stark and stop & server and do server configuration. You may
onfiguration create a Profile without remate ranagenent if you do nok need that Functionality,

If wour database server is running on the same machine as this application select localhost, Otherwise
please specify the TCPJIP address or the network name of the remote maching, You may also pick an
existing database connection.

(%) localhost

() Remote Host

Address: | Either IP Address or Hostname

() Take Parameters from Existing Database Connection

Lacal inskance MySQLSS (User: root Host: localhost: 3308)

Back [ Hest ]L Cancel J

4. Next you will set up a connection, or select an existing connection to use to connect to the server.
Assuming that you have not already created a connection, you can use the default values here,
although if your MySQL Server has a password set for the r oot account, you can enter it here by
clicking Store in Vault. This enables you to connect to the server without needing to enter a password
each time. It is also possible to use a different account to connect to the server by setting the user
name and password here, if required.
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Figure 4.3. Getting Started Tutorial - Database Connection

Create MNew Server Instance Profile [x]

sk Machine

Set the Database Connection values

Zonneckion Mame: ||Dca|hc:st | Type a name for the connection
Connection Mathod: | Standard (TCRIIF) - | Method ko use ko connect to the RDEMS
Parameters | advanced |
Hostname: ||Dca|host | Port: |3306 | Mame or IP address of the server host - TCP(T

Username: |r00t Marme of the user ko connect: with,

Password: I_ Skore in Yault ... ] l Clear J The user's passward,

The schema that will be used as default schem

Default Schema: |

[ Back J[ M et ]L Cancel J

You can now click Next.

5. The connection will now be tested. You should see that the connection was successful. If not click Back
and check that you have entered the information required.
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Figure 4.4. Getting Started Tutorial - Connection Test

Create New Server Instance Profile [x]

Testing the Database Connection

The database conmection information is being tesked. This might take a fFew moments depending on vour network
conneckian,
Managemenk anc

(¥} Open Database Connection

onfiguration

() @t Server Version: 5.5.16
() Get Server O5: Windows

Database connection tested successiully,

[ Back J[ VRS ][ Caticel ]

If the connection test was successful, click Next.

Optionally, you may configure a method for remote management if a Remote Host was specified.
Setting these options enables MySQL Workbench to determine the location of configuration files, and
the correct start and stop commands to use for the server.

SSH login based management and Native Windows remote management types are available. The
Operating System and MySQL Installation Type are configured for the SSH login variant.
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7.

Figure 4.5. Getting Started Tutorial - Management and OS

Create New Server Instance Profile [x]

st Machine

Specify remote management type and target operation system
onnection
B Connection Select the bype of remote management you wankt to use:
Management and 05 (7 Do niok use remote management
onfiguration ) Native Windows remate management (only available on Windows)

(%) 55H login based management

Operating Sysken Selection

Select the operating svstem and the tvpe of database installation on the target machine. If you are unsure
about the bype of database installation select the (Yendor Package) variant, If vour specific operating system is
nat in this list, selact a related variant, It can later be cuskomized, if needed,

Operating Syskem: | Windows L' |

IMySQL Installation Tyvpe: | w |

[ Back ][ M et ][ Cancel ]

Set the configuration method, then click Next.

If the SSH login based management was chosen, then you will configure its parameters which includes
the User Name, Host Name, and optionally the SSH key for authentication.
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Figure 4.6. Getting Started Tutorial - SSH Configuration

Create New Server Instance Profile [x]

Set remote SSH configuration parameters

Conneckion
 Connection In order to remokely configure this database instance an 55H account on this host with appropriate privileges is
reguired, This account needs write access ko the my.cnf database config file, read access to the database logs and
Management and privileges to start/stop the database daemon,
55H Configuration Hast Marne: | | Port: |22 |
Windows Managenment User Mame: | |

[] authenticate Using 55H Key

S5H Public Key Path: |C:'|,D0cuments and Settings) The TestyApplication Dataf.sshfid_rsa |

[ Back ][ M et ][ Cancel ]

Check that everything is in order, then click Next.

8. If a Windows server is used, then the Windows configuration parameters must be set.
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Figure 4.7. Getting Started Tutorial - Windows Management

Create Mew Server Instance Profile

sk Machine

onfiguration

Windows Management

Set Windows configuration parameters for this machine

Windows management requires a user account on this machine which has the required privileges to query
system status and to conkrol services. For configuration File manipulation readfwrite access ta the File is

needed.

Select the service to manage from the list below, It will also help to find the configuration File,

MySQLSS (Running, Start mode: Auko)

]

Path to Configuration File: | C:\Docurments and Settingsial Usersiapplication DatalMySQLIMYSOL Server | D

l

Back

J {

VRS

][ Cancel J

Check that everything is in order, then click Next.

9. The wizard will now check that it is able to access the MySQL Server configuration file, and access the

start and stop commands.
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Figure 4.8. Getting Started Tutorial - Test Host Settings

Create New Server Instance Profile [x]

Testing Host Machine Settings

The connection ko the hast machine is being tested. This might take a Few moments depending on wour network
conneckian,
Managemenk anc

Connect bo host machine

onfiguration

Check lacation of startfstop commands
s Management
) Check MySGL configuration file

Test Settings
Testing hast machine settings is done.

[ Back J[ VRS ][ Caticel J

Check that everything is in order, then click Next.

10. You now have a chance to review the configuration settings so far. The information displayed varies
slightly depending on platform, connection method and installation type.
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Figure 4.9. Getting Started Tutorial - Review Settings

Create Mew Server Instance Profile

Review Settings

rifig File

Canple

Review Server Instance Settings

Belaw is alist of all settings collected so Far. This includes also walues taken From templates or default values, Check
if thew makch wour ackual settings and toggle 'Change Parameters' iF wou need ko make any changes to default
walues, Far ary other change go back ko the appropriate wizard page.

Pz special atkention if wou run rore than one instance of MySOL on the same machine.

Mative Windows Adminstration enabled
Windows host: localhost
MySOL service name: MwSGLSS

MySGL Configuration

MySOL Version: 5.5.16

Settings Template:

Path to Configuration File: C:\Documents and SettingsiAll Usersiapplication DatayMySOLYMySCL Server
5. 5hmy.ini

Instance Mame in Configuration File: mysgld

[] change Parameters

[ Back J[ et ][ Cancel ]

Review the information, then click Next.

11. Finally you can give the server instance a suitable name. This will be used to select this particular
instance from a list of available instances.
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Figure 4.10. Getting Started Tutorial - Instance Name

Create New Server Instance Profile [x]
Create the Instance Profile
Plzase enter a name For this server instance and click Mext, & new Server Instance Profile entry will be created For

rnanaging this MySOL server,
Managemenk anc

Server Instance Mame:  |[mysgld@localhost

onfiguration

Commands

Complete Setup

[ Back J[ Firish ][ Cancel J

Set the desired name, then click Finish to complete the server instance creation process.

12. You will now be returned to the Home window. You will see the new server instance you created, along
with the new connection you created as part of the preceding procedure.

23



Administering a MySQL Server

Figure 4.11. Getting Started Tutorial - Home Window Instance

MySQL Workbench o B

File Edit View Database Plugins Scripting Community Help

Workbench Central v

R Welcome to MySQL Workbench

4 What's New in This Release?

LLTE \
Workbench Read about all changes in this My5QL Workbench release. MysQLDoc  MySQLBug  Workbench PlanetMySQL  Workbench
Library Reporter Team Blog Farums
Workspace

SQL Development B | Data Modeling Server Administration
Connect to existing databases and run i //A Create and manage models, forward & Configure your database server, setup
SQL Queries, SQL scripts, edit data and reverse engineer, compare and user accounts, browse status variables
manage database objects. synchronize schemas, report. and server logs.

/Z Open Connection to Start Querying ». Open Existing EER Model = Server Administration
14 @ ce
7 localhost 5 mysqld@localhost
User root Host localhost:3306 Local Type: Windows
QA New Connection ] New Server Instance
Eﬂ Edit Table Data ﬂa& Create New EER Model ﬁ Manage Import [ Export
s, Edit SQL Script =, Create EER Model From Existing Database .” Manage Security
L i ]
. Manage Connections [ Create EER Model From SQL Script -~ Manage Server Instances
b a3 akt

New server instance created.

You are now ready to test your new server instance.

13. From the Home window, double-click the Server Instance you created. The Administrator will open on
the Startup configuration page.
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Figure 4.12. Getting Started Tutorial - Admin Startup

e 0e MySQL Workbench

#  Admin (mysqld@localhost)
MANAGEMENT Server Status

g z T INFO SYSTEM SERVER HEALTH

G SRR Pamia MName: mysqld@localhost
Status and System Variables S P Host: localhost
A Server Logs {@d Server: 5.5.15-log
Status: Running Load: -~ Mem: 68% Connection Usage: Traffic: 7.00 KB/s  Query Cache Hitrate: 0.0¢ Key Efficiency: 0.00
CONFIGURATION
o CONNECTIONS

# Options File Id User Host DB Command Time State Info
SECURITY 2 root localhost:49320 Query 0 SHOW PROCESSLIST

=& Users and Privileges 3 root localhost: 49322 Sleep 2
DATA EXPORT / RESTORE

;b Data Export

;L Data Import/Restore

Kill Query Kill Connection | Refresh |

WEB Admin Opened

14. Click the Stop Server button. The message window will show that the server has stopped.

15. Click the Start Server button to resume the server. The message window will confirm that the server is
running.

You have now seen how to create a server instance to enable you to manage a MySQL server.

For further information, see Chapter 9, Server Administration.

4.2. Creating a Model

In this section, you will learn how to create a new database model, create a table, create an EER Diagram
of your model, and then forward engineer your model to the live database server.

1. Start MySQL Workbench. On the Home window, select Create new EER Model. A model can contain
multiple schemata. Note that when you create a new model, it contains the nydb schema by default.
You can change the name of this schema to serve your own purposes, or delete it.
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Figure 4.13. Getting Started Tutorial - Home Window
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On the Physical Schemata toolbar, click the button + to add a new schema. This will create a new
schema and display a tabsheet for the schema. In the tabsheet, change the name of the schema
to “dvd_collection”, by typing into the field called Name. Ensure that this change is reflected on the
Physical Schemata tab. Now you are ready to add a table to your schema.
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Creating a Model

Figure 4.14. Getting Started Tutorial - New Schema
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In the Physical Schemata section, double-click Add Table.

This will automatically load the table editor, with the default table name being tablel. In the table editor,
change the name of the table from “table1” to “movies”.

Next, add several columns. Double click a cell within the Column Name column, and the first field
will default to “moviesid” because MySQL Workbench appends “id” to the table name as the default
for the initial field. Change the name to “movie_id” and keep the Datatype as | NT. Then, be sure PK
(PRIMARY KEY), NN (NOT NULL), and Al (AUTO_INCREMENT) are all checked.

Add two additional columns using the same method as described above:

Column Name Data Type Column Properties
movie_title VARCHAR(45) NN
release_date DATE (YYYY-MM-DD) None
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Figure 4.15. Getting Started Tutorial - Columns
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7. Now you can obtain a visual representation of this schema so far. From the main menu, select Model,
Create Diagram from Catalog Objects. The EER Diagram will be created and displayed.
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Figure 4.16. Getting Started Tutorial - EER Diagram
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8. In the table editor, change the name of the column “movie_title” to “title”. Note that the EER Diagram is
automatically updated to reflect this change.

9. Atthis point, you can save your model. Click the main toolbar button Save Model to Current
File. You have not yet saved this file so you will be prompted to enter a model file name. For this
tutorial, enter “Home_Media”. The Home_Media model may contain further schemata in addition to
dvd_col I ection,suchascd _col |l ecti on. Click Save to save the model.

10. You can synchronize your model with the live database server. First, you must tell MySQL Workbench
how to connect to the live server. From the main menu, select Database, Manage Connections....

11. In the Manage DB Connections dialog, click New.

12. Enter “Big Iron Server” for the connection name. This enables you to identify the server to which this
connection corresponds, although it is possible to create multiple connections to the same server.

13. Enter the user name for the account you will use to connect to the server.

14. Click on the Store in Vault... button and enter the password for the user name you entered in the
previous step. You can optionally ignore this step, and you will be prompted for this password
whenever MySQL Workbench connects to the server.

15. Click Test Connection to test your connection parameters. If everything is okay at this point, you can
click Close.
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Figure 4.17. Getting Started Tutorial - Manage Connections
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16. You are now ready to forward engineer your model to the live server. From the main menu, select
Database, Forward Engineer.... The Forward Engineer to Database wizard will be displayed.

17. The Options page of the wizard shows various advanced options. For this tutorial, you can ignore these
and simply click Next.

18. On the next page, you can select the object you want to export to the live server. In this case, you only
have a table, so no other objects need be selected. Click Next.

19. The next page, Review SQL Script, displays the script that will be run on the live server to create your
schema. Review the script to make sure that you understand the operations that will be carried out.
Click Next.
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Figure 4.18. Getting Started Tutorial - Review Script
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20. Select the connection you created earlier, “Big Iron Server”. Click Execute. Check the messages for
any errors, then click Close to exit the wizard.

21. Ensure that the script ran without error on the server, then click Close. As a simple test that the script
worked launch the MySQL Command Line Client (mysql ). Enter SHONV DATABASES; and identify your
schema. Enter USE dvd_col | ecti on; to select your schema. Now enter SHOW TABLES; . Enter
SELECT * FROM novi es; , this will return the empty set as you have not yet entered any data into
your database. Note that it is possible to use MySQL Workbench to carry out such checks, and you
will see how to do this later, but the MySQL Command Line Client has been used here as you have
probably used it previously.

22. Ensure that your model is saved. Click Save Model to Current File on the main toolbar.

4.3. Adding Data to Your Database

In the previous section, you created a model, schema, and table. You also forward engineered your model
to the live server. In this section, you will see how you can use MySQL Workbench to add data into your
database on the live server.

1. On the Home window, click the link Edit Table Data in the SQL Development area of the Workspace.
This launches Edit Table Data wizard.
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Figure 4.19. Getting Started Tutorial - Edit Table Data
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2. Inthe wizard, select the “Big Iron Server” connection from the stored connection list. Click Next.
3. Select the schema, dvd_col | ecti on. Select the table to edit, novi es. Click Finish.

4. You will see a data grid. This is where you can enter the data for your database. Remember that the
nmovi e_i d was set to be autoincrement, so you need not enter values directly for this column. In the
data grid, enter the movie information shown in the following table.

title release_date
Gone with the Wind 1939-04-17
The Hound of the Baskervilles 1939-03-31
The Matrix 1999-06-11
Above the Law 1988-04-08
Note
S Do not modify any values in the novi e_i d column.

5. Now click the Apply button in the toolbar located in the bottom right corner. A list of SQL statements will
be displayed. Confirm that you understand the operations to be carried out. Click Apply to apply these
changes to the live server.

6. Confirm that the script was executed correctly, then click Finish.
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7. View the data grid again and observe that the autoincrement values have been generated.

Figure 4.20. Getting Started Tutorial - Edit Data
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8. Now you will check that the data really has been applied to the live server. Launch the MySQL
Command Line Client. Enter SELECT * FROM novi es; to see the data just entered.

9. You can also carry out a similar check from within MySQL Workbench. Click on the Home window tab.

10. Click the link Open Connection to start Querying in the SQL Development section of the Workspace.
This will launch the Connect to Database dialog. Select “Big Iron Server” from the list. Click OK.

11. A new SQL Editor tab will be displayed. In the SQL Statements area, enter the following code:

USE dvd_col | ecti on;
SELECT * FROM novi es;

12. Now click the Execute toolbar button. This resembles a small lightning bolt. The SQL Editor will display
a new Result tab contain the result of executing the SQL statements.
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Figure 4.21. Getting Started Tutorial - Results
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In this section of the tutorial, you have learned how to add data to your database, and also how to execute

SQL statements using MySQL Workbench.
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When MySQL Workbench first starts, it presents the Home window, which has two main sections:
» Workbench Central

» Workspace

displays the MySQL Model workspace rather than the Home window. Note that 5.1

Note
@ MySQL Workbench 5.2 introduced the Home window. MySQL Workbench 5.1
does not support the SQL Editor and Server Administration functionality of 5.2.

The two sections can be seen in the following screenshot. For more information, see the following sections.
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Figure 5.1. The Home Window
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5.1. Workbench Central

Workbench Central enables you to keep up to date with MySQL Workbench news, events, and resources.
You can read the developer blogs, find out what's new in the release, access the forums, check for

updates, and file a bug report.

Workbench Central includes the following facilities:

» What's new: A list of bug fixes and changes

* MySQL Doc Library: Built-in documentation

» MySQL Bug Reporter: Links to the MySQL bug system, where you can report bugs
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» Workbench Team Blog: Links to the Workbench team blog
» Planet MySQL: Links to MySQL-related blogs and news

» Workbench forums: Links to the MySQL user and developer forums
5.2. Workspace

The Workspace is designed to enable you to quickly get to the task you would like to carry out. In
alignment with MySQL Workbench functionality, it is divided into three main areas:

e SQL Development. For further information, see Chapter 6, SQL Development.
» Data Modeling. For further information, see Chapter 7, Data Modeling.

» Server Administration. For further information, see Chapter 9, Server Administration.

5.3. Workbench Application Minimum Window Size

As of version 5.2.10, the MySQL Workbench application features a fixed minimum window size of
1024x768. You cannot reduce the size of the application to less than this resolution.

5.4. Workbench Preferences

The Preferences menu sets MySQL Workbench defaults. Choosing this menu item opens the following
dialog box.

37



Workbench Preferences

Figure 5.2. The Pr ef er ences Dialog Box
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The preferences dialog box contains the following tabs:

» General: Configuration of general-purpose options

» Administrator: Configuration of tools used by the Administrator functionality

» SQL Editor: Configuration of the SQL Editor

» Model: Default object names

» MySQL: Configuration of the default storage engine

» Diagram: EER diagram settings

» Appearance: Change colors and fonts used by various Workbench components

A more detailed discussion of these options follows.
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5.4.1. The General Tab

The General tab enables you to set the following options:

Automatically Reopen Previous Model When Started: Check this if you want the model on which you
previously worked to be automatically reopened when you start MySQL Workbench.

Place Sidebar on the Right Side: By default, the Sidebar is placed on the left-hand side of the MySQL
Workbench application. Select this option to place it on the right-hand side.

Force use of software rendering for EER diagrams: MySQL Workbench will use OpenGL for
rendering when available. However, due to faulty drivers, problems do occasionally occur. These issues
can be resolved by selecting the software rendering option here.

Undo History Size: You can limit the size of the undo history here. Set this value to 0 to have an
unlimited undo history.

Auto-save model interval: An open model that has not been saved will automatically be saved after
this period. On loading a model file, MySQL Workbench will notify the user if the file was not previously
saved correctly, due to a crash or power failure. MySQL Workbench can then attempt to recover the last
auto-saved version. For automatic recovery to be available for a new file, it will have to have been saved
at least once by the user.

Interactive GRT Shell Language: You can select the language to be used in the GRT (Generic
RunTime) shell by choosing a language from the list Interactive GRT Shell Language. Currently, the
choices are Lua and Python. Python is the recommended option.

Create new tabs as Query tabs instead of File: By default, opening a new SQL Editor tab opens as an
SQL File tab. Check this option if you prefer the simpler Query tabs that, for example, will not prompt to
be saved when closed. Added as of MySQL Workbench 5.2.45.

5.4.2. The Administrator Tab

This section provides configuration options that affect the Administrator functionality in MySQL Workbench.
It enables you to set paths to the mysql dunp and nmysql tools. If these paths are left blank, the defaults
are used. This panel also enables you to set the directory for export dump files.

5.4.3. The SQL Editor Tab

This section provides configuration options that affect the SQL Editor functionality in MySQL Workbench.

There are three main groups of parameters that can be set here:

SQL properties
Query Editor

Query Results

SQL Properties

SQL properties that can be set include the SQL_MODE, case sensitivity of identifiers, and the SQL delimiter
used.

The document property Sql Mode defines SQL_ MODE for all operations affecting SQL parsing at the
document scope. The purpose of this option is to preserve the consistency of SQL statements within the
document.
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The property has the following functions:

e Sets the SQL_MODE DBMS session variable to the value stored in the Sql Mode property of the
document when performing reverse engineering, forward engineering, or synchronization operations.

» Honors the SQL_MODE values defined in Sql Mbde so that SQL parsing is correct.

Only a subset of all possible SQL_ MODE values affect the MySQL Workbench SQL parser. These
values are: ANSI _QUOTES, HI GH_NOT_PRECEDENCE, | GNORE_SPACE, NO_BACKSLASH_ESCAPES,
Pl PES_AS CONCAT. Other values do not affect the MySQL Workbench SQL parser and are ignored.

If the value of Sql Mbde is not set, the default value of the SQL_ MODE session variable defined by

the server stays unchanged during operations with the server. However, the MySQL Workbench

SQL parser behaves as if SQL_MODE is also not set. This may potentially lead to inconsistencies in
parsing of SQL statements stored in the document. If you choose to not set the Sgl Mode property,
ensure that the default SQL_ MODE variable defined by the server does not contain any values from the
following list: ANSI _QUOTES, HI GH_NOT _PRECEDENCE, | GNORE_SPACE, NO_BACKSLASH_ESCAPES,
Pl PES_AS_CONCAT.

The Sgl Mode property is defined in two locations: globally and at document scope. MySQL Workbench
uses the global property to initialize the document property for each new document created. For each
document, the property value defined at document scope always has higher priority over the one defined
globally.

Query Editor
The query editor properties that can be set include the following:

» Show Live Schema Overview: This option enables a simplification of the user interface by removing the
Overview tab from the SQL Editor. This is extremely useful if schemata have a large number of tables, or
a model has a large number of schemata. In each of these cases, load times would be greatly increased
as the tables and schemata are enumerated and drawn.

« Show Schema Contents in Schema Tree: Enumerating, populating, and drawing large numbers of
items can significantly increase loading times. For this reason, this facility can be switched off for models
containing large numbers of schemata and tables.

» Show Metadata Schemata: By default metadata schemata are not displayed. To display them, for
example to troubleshoot or check metadata information, select this option.

e Continue on SQL Script Error: Should an error occur while executing a script, this option causes
execution to continue for the remainder of the script.

e Forbid UPDATE and DELETE statements without a WHERE clause: This option enables the
SQL_SAFE_UPDATES option for the session, preventing UPDATE and DELETE statements from being
executed if a WHERE clause is not present. This can avoid potentially dangerous situations where a
statement could accidentally update or delete all rows in a table.

e Max syntax error count: Large complex scripts can contain many errors. Further, a syntax error early
on can lead to many subsequent syntax errors. For these reasons, it is possible to limit the number of
errors displayed using this option. The default is 100 error messages.

» Progress status update interval: When executing long running queries over a slow connection, you
may need to increase this value to prevent excess load on the connection.

 DBMS connection keep-alive interval: When executing long running queries over a slow connection,
you may need to increase this value to prevent the connection being lost.
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Query Results
The query results properties that can be set include the following:

« Limit Rows: Queries can sometimes return an excessive number of rows, which can heavily load
the connection, and take time to display in MySQL Workbench. To prevent this, you can set a more
moderate value here.

e Limit Rows Count: Specify the maximum number of result rows to return.

» Max. Field Value Length to Display: To avoid display problems due to excessive field length, it is
possible to set the maximum field length to display (in bytes).

» Treat BINARY/VARBINARY as non-binary character string: Binary byte string values are not
displayed by default in the results grid, but are instead marked as BLOB values. These can then be
viewed or edited with the BLOB editor. Nonbinary character string values are displayed in the results grid,
and can be edited in the grid cell or using the BLOB editor.

If this option is turned on, data truncation may result: Binary byte string values may contain null bytes as
part of their valid data, whereas for nonbinary character strings, a null byte terminates the string.

« Enable Data Changes Commit Wizard: In the SQL Editor, if you edit table data and then click the
Applying changes to data button, MySQL Workbench launches a wizard to step you through applying
your changes. This gives you a chance to review the SQL that will be applied to the live server to make
the requested changes. If this option is deselected, the changes will be applied to the server without the
wizard being displayed and without giving you a chance to review the changes that will be made.

5.4.4. The Model Tab

This section provides configuration options that affect the Modeling functionality in MySQL Workbench.

Use the When Deleting Physical Model Figures in Diagram section to determine the behavior when
deleting objects from the EER diagram canvas. Choose Ask and whenever you delete an object, you will
be asked whether you wish to remove the object from an EER diagram only or also from the catalog. The
Keep Dat abase Object in Catal ogis the safest option. You also have the option of deleting the
object from both the EER diagram and the catalog.

deleting an object from an EER Diagram. When deleting in the MySQL Model view,
there is no confirmation dialog window and the delete action always removes the

Note
@ If you choose the Ask option, a confirmation dialog box opens only when you are
object from the catalog.

There are a variety of ways to delete an object from an EER canvas: using the er aser tool; choosing a
pop-up menu item; using the delete key; and by choosing the delete option from the Edit menu. In each
case, the action performed by the delete key is determined by the option chosen from the When Deleting
Physical Model Figures in Diagram section.

Use the Model tab to set the default value for various object names and the primary key data type. The
following table shows the object names and their default values.

Object Name Default Value
PK Col utm Narne i d% abl e%
PK Col um Type I NT
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Object Name Default Value

Col um Nane % abl e%col

Col um Type VARCHAR( 45)

FK Nane f k%t abl e_%dt abl e%
Forei gn Key Col unm Nane % abl e% %ol uMm%

ON UPDATE NO ACTI ON

ON DELETE NO ACTI ON

Associ ative Tabl e Name %st abl e% has_%lt abl e%

The PK Column Name, PK Column Type, Column Name, and Column Type values are the defaults
used by the table editor, and only function on Microsoft Windows and Mac OS X. The others are the default
names used when using the relationship tools on an EER diagram.

Within object values items enclosed by percentage signs are variables. Their meanings are as follows:
* % abl e% The table associated with the object

» Ust abl e% The source table associated with the object

» %t abl e% The destination table associated with the object

* %ol um% The column associated with the object

Legitimate values for the foreign key update or delete rules are:

RESTRI CT

CASCADE

SET NULL
« NO ACTI ON (default)

For more information about these actions, see Section 7.7.1.3.4, “The Foreign Keys Tab”.

5.4.5. The MySQL Tab

This enables you to set the default table storage engine.

5.4.6. The Diagram Tab

Use this tab to determine display settings for an EER diagram.

Select whether to expand new objects by checking the Expand New Objects check box and select
whether to draw line crossings by checking the Draw Line Crossings check box.

This tab also enables you to set the maximum number of characters for the following items:
* Column Names
e Column Types
* Routine Names

Changes to these values change the display properties only, not the objects themselves.
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5.4.7. The Appearance Tab

Use this tab to set the available colors for the objects that appear on an EER diagram canvas. You can
also add colors if you wish.

Changes made here affect the list of colors that appears on the toolbar when adding objects to an EER

diagram canvas. For information about using this list, see Section 7.5.2.1, “Tool-Specific Toolbar Items”.
You can also use this tab to set the font face, size, and style for the following items:
 Editor

» Layer Title

e Text Figure Text

» Text Figure Title

» Connection Caption

» Routine Group Figure Iltem

» Routine Group Figure Title

» Table Figure Items

» Table Figure Section

» Table Figure Title

* View Figure Title

you need to use characters not supported by the | at i n- 1 character set, you must

Note
@ On Windows, the default font for the editor supports only | at i n- 1 characters. If
change the font here.
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Chapter 6. SQL Development
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MySQL Workbench provides extensive facilities for working directly with SQL code. Before working directly
with a live server, a connection must be created. After a connection is established, it is possible to execute
SQL code directly on the server and manipulate the server using SQL code.

The starting point for embarking on SQL Development work is the SQL Development area of the Home
window, which has the following action items:

Open Connection to start Querying
New Connection

Edit Table Data

Edit SQL Script

Manage Connections

The following sections describe each of these action items.

Note
@ The SQL Development facility in MySQL Workbench provides the functionality that

was formerly available in MySQL Query Browser.

6.1. Open Connection to Start Querying

Clicking this action item launches the Connect to Database Wizard. From this wizard, you can select a
predefined connection. A new SQL Editor tab is launched.

If you already have created a connection to a database, it will appear in this panel as an icon. Double-
clicking the icon directly launches an SQL Editor tab, and connects you to the database as defined by the
connection.
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To read more about the SQL Editor, see Section 6.7, “SQL Editor”.

6.2. New Connection

Clicking the New Connection action item launches the Manage DB Connections wizard. This wizard
enables you to create a new connection. Note that the wizard when launched from here does not display
existing connections, it only enables you to create a new connection.

To read more about creating and managing connections, see Section 6.6, “Manage DB Connections
Dialog”.

6.3. Edit Table Data

Clicking this action item launches the Edit Table Data wizard, which enables you to edit table data. This is
a two-stage wizard. The first stage enables you to select a Stored Connection. The second stage enables
you to select the Schema and Table you want to edit. After the wizard is completed, an SQL Editor tab is
launched, which displays a data grid that enables you to interactively edit table data as required.

To read more about the SQL Editor, see Section 6.7, “SQL Editor”.

6.4. Edit SQL Script

Clicking this action item launches the Edit SQL Script wizard. This is a two-stage wizard. The first stage
enables you to select a Stored Connection. The second stage enables you to select an SQL Script file, and
optionally have the script executed after it is opened. After the wizard is completed, an SQL Editor tab will
be launched, with the script displayed. If you selected to run the script, MySQL Workbench runs the script
and displays the results.

Working with large data sets
@ The Edit SQL Script wizard is not well-suited for executing large dump files, and
instead the Server Administration, Manage Import/Export feature should be used.

6.5. Manage Connections

Clicking this action item launches the Manage DB Connections wizard. This wizard also displays Stored
Connections, which can be selected and changed as desired. This wizard can also be used to create new
connections.

To read more about managing connections, see Section 6.6, “Manage DB Connections Dialog”.

6.6. Manage DB Connections Dialog

MySQL Workbench provides a Manage DB Connections dialog for creating and managing connections

to servers. The connections created can then be used from the wizards that must connect to a server,
such as the wizard used to reverse engineer a live database. Howeuver, it is still possible to set connection
parameters from these wizards if required, without invoking the Manage DB Connections dialog directly.

The Manage DB Connections dialog is invoked by selecting Database, Manage Connections from the main
menu. It can also be invoked from any of the wizards requiring access to a live database. This is achieved
by using the Manage Stored Connections item, found in the wizard's Stored Connection list.

After the Manage DB Connections dialog is launched, you are presented with the following dialog, which
enables you to create or delete connections.
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The Password Storage Vault

Figure 6.1. Manage DB Connections - Dialog

.
=] Manage DE Connectionsiiil - - « & T | E
Stored Connections Connection Mame: Big Iron Server Type a name for the connection f
L-:al instance MySQLSS Connection Methad: ~ Standard (TCF/IF) + Method to use to connect to the RDEMS
Big Iron Server
localhost Parameters | Advanced
Hostname: 127.0.0.1 Port: 3306 Mame or IP address of the server host - TCP/IP port
Username: root Name of the user to connect with,
Password: Store in Vault ... ] [ Clear The user's password.
Default Schema: The schema that will be used as default schema
[ Mew ] [ Delete ] [ Duplicate ] [ Move Up ] [ Mowe Down ] [ Test Connection ] [ Close ]

- il

Click New to create a new connection. Once created, the connection can be selected from the Stored
Connections list. You can then set various parameters for the connection, including the following:

» Connection Name: The name used to refer to this connection. This connection can then be selected
from a list in other wizards requiring a connection.

» Connection Method: The methods available are Standard TCP/IP, Local Socket/Pipe, and Standard
TCP/IP over SSH.

After you select a connection method, the fields available in the Parameters tab and the Advanced tab
of the dialog changes accordingly. More details about these options and parameters are available in the
following sections.

After all parameters have been set as required, you can click the Test Connection button to test the
connection to the live server. After you are satisfied that the connection works as expected, you can close
the wizard by clicking the Close button. The stored connection then is available for use from any of the
wizards requiring a connection to a live server.

You can duplicate an existing connection using the Duplicate button. This is an easy way to begin setting
up a new connection that differs only slightly from an existing one.

6.6.1. The Password Storage Vault

The vault provides a convenient secure storage for passwords used to access MySQL servers. By using
the vault, you need not enter credentials every time MySQL Workbench attempts to connect to a server.
The vault is implemented differently on each platform:

» Windows: The vault is an encrypted file in the MySQL Workbench dat a directory. This is where
connections. xm and related files are located. The file is encrypted using a Windows API which
performs the encryption based on the current user, so only the current user can decrypt it. As a result it
is not possible to decrypt the file on any other computer. It is possible to delete the file, in which case all
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stored passwords are lost, but MySQL Workbench will otherwise perform as expected. You then must
re-enter passwords as required.

* Mac OS X: The vault is implemented using the Mac OS X Secure Keychain. The keychain contents can

be viewed using the Keychai n Access. app utility.

Linux: The vault works by storing passwords using the gnone- keyr i ng daemon, which must be
running for password persistency to work. The daemon is automatically started in GNOME desktops, but
normally is not in KDE and others. The gnone- keyr i ng daemon can be used for password storage in
MySQL Workbench on non-GNOME platforms, but must be started manually.

6.6.2. Standard TCP/IP Connection

This connection method enables MySQL Workbench to connect to MySQL Server using TCP/IP.

Parameters tab

Hostname: The host name or IP address of the MySQL server.
Username: User name to use for the connection.

Password: Optional password for the account used. If you enter no password here, you will be
prompted to enter the password when MySQL Workbench attempts to establish the connection. MySQL
Workbench can store the password in a vault (see Section 6.6.1, “The Password Storage Vault”).

Port: The TCP/IP port on which the MySQL server is listening (the default is 3306).

Default Schema: When the connection to the server is established, this is the schema that will be used
by default. It becomes the default schema for use in other parts of MySQL Workbench.

Advanced tab

More parameters can be set for the connection by using the Advanced tab.

Figure 6.2. Manage DB Connections - Advanced Tab

EI Manage DB Connections - - - ‘ - — | —[o] X .|“
Stored Connections Connection Mame:  Big Iron Server Type a name for the connection f
Il;iogn’:allr;:s;ael:::rMySQLSE Connection Methed:  Standard (TCP/IF) + Method to use to connect to the RDBMS
localhost W
[7] Use compression protocol Select this option for WAN connections.
[7] use ANSI quotes to quote identifiers. If enabled this option overwrites the serverside settings.
[ Use s5L if avaiable This option turns on 551 encryption if the dient library supparts it
SSL CA File: Path to Certificate Authority file for S5L.
S5L CERT File: Path to Certificate file for S5L.
S5L Key File: Path to Key file for S5L.
S5L Cipher: Optional list of permissible ciphers to use for S5L encryption.
Mew ] [ Delete ] [ Duplicate ] [ Mowve Up ] [ Mowve Down Test Connection ] [ Close
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The Advanced tab includes these check boxes:

» Use compression protocol: If checked, the communication between the application and the MySQL
server will be compressed, which may increase transfer rates. This corresponds to starting a MySQL
command-line client with the - - conpr ess option.

* Use SSL if available: This option turns on SSL encryption. The client library must support this option.
Note: This feature is currently not supported.

» Use ANSI quotes to quote identifiers: Treat “*” as an identifier quote character (like the “*” quote
character) and not as a string quote character. You can still use “*” to quote identifiers with this mode
enabled. With this option enabled, you cannot use double quotation marks to quote literal strings,
because it is interpreted as an identifier. Note: If this option is selected, it overrides the server setting.

6.6.3. Local Socket/Pipe Connection

This connection method enables MySQL Workbench to connect to MySQL Server using a socket file (on
Unix) or a named pipe (on Windows).

Parameters

The unique field here is Socket/Pipe Path. Enter the name of the socket or pipe here. If the field is left
blank, the default socket or pipe name is used. On Unix, the default socket name is / t np/ nysql . sock.
On Microsft Windows, the default pipe name is My SQL.

This option can be seen in the following screenshot.

Figure 6.3. Manage DB Connections - Socket/Pipe Parameters

r_ﬁ' Manage DB Connections
k
Stored Connections Connection Name:  Big Iron Server Type a name for the connection
Llocal instance My5QL55 Connection Method:  Local Socket/Fipe » Method to use to connect to the RDEMS
Big Iron Server
localhost Parameters | Advanced
I Socket/Pipe Path: Path to local socket or pipe file, Leave empty for default.
Username: root Mame of the user to connect with.
Passward: [ Store in Vault ... ] [ Clear The user's passward.
Default Schema: The schema that will be used as default schema
[ e ] [ Delete ] [ Duplicate ] [ Move Up ] [ Mowve Down Test Connection ] [ Close ]
—= J
Advanced

The only option available in this tab is Use ANSI quotes to quote identifiers. This option was discussed
in Section 6.6.2, “Standard TCP/IP Connection”.
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Standard TCP/IP over SSH Connection

6.6.4. Standard TCP/IP over SSH Connection

This connection method enables MySQL Workbench to connect to MySQL Server using TCP/IP over an
SSH connection.

Parameters

In addition to a number of parameters that are in common with Standard TCP/IP connections, this
connection method features a number of specialized parameters. These are listed here:

» SSH Hostname: This is the name of the SSH server. An optional port number can also be provided.
* SSH Username: This is the name of the SSH user name to connect with.
» SSH Password: The SSH password. It is recommended that an SSH key file is also used.

» SSH Key File: A path to the SSH key file. Note: Only key files in OpenSSH format are currently
supported.

These options can be seen in the following screenshot.

Figure 6.4. Manage DB Connections - SSH Parameters

Manage DB_Connecﬁons
Stored Connections Connection Mame:  Big Iron Server Type a name for the connection
Il;iogn’:allr;:s;ael:::rMySQLSE Connection Methed: ~ Standard TCPfIP over S5H + Method to use to connect to the RDBMS
localhost m
S5H Hostname:  127.0.0.1:22 55H server hostname, with optional port number
S5H Username:  user Mame of the S5H user to connect with.
55H Password: Store in Vault ... ] [ Clear ] Password for the 55H tunnel.
SSH Key File: E] Path to SSH private key file,
MySQL Hostname:  127.0.0.1 MyS0L server host relative to the S5H server
MySQL Server Port: 3306 TCP/IP port of the MySQL server
Username:  root Mame of the user to connect with,
Password: [ Store in Vault ... ] [ Clear The MySQL user's password.
Default Schema: The schema that will be used as default schema
[ Mew ] [ Delete ] [ Duplicate ] [ Mowve Up ] [ Maowe Down Test Connection ] [ Close ]

LS = =

Advanced

The options here are the same as for the Standard TCP/IP connection. See Section 6.6.2, “Standard TCP/
IP Connection”.

6.7. SQL Editor

MySQL Workbench 5.2 introduced the SQL Editor facility. The SQL Editor can be launched using various
action items on the Home window. It can also be launched by selecting Database, Query Database from
the main menu, or by using the keyboard shortcut Control+U on Windows, or Command+U on Mac

50



Main Menu

OS X. At this point, you will be asked to either select a stored connection or enter the details for a new
connection. After a connection has been made to the server, a new tab called SQL Editor (schenn) is

displayed.

Figure 6.5. SQL Editor

800 MySQL Workbench
& | sqL Editor (localhost) |
o £ [E=iT)
SCHEMAS o § B Country x Snippets
Q e8| FFACAICORA ¢/ a[ Vg o [ MySnipgets ]
B il ecuoy 1e SELECT * FROM world.Country;
P | sakila 1008 4] 11
et Filter: (Q, ) | Edic g B i | Expor: HY
> el Code Name Continent Region SurfaceArea IndepYear Popul.
ABW Aruba North America  Caribbean 193.00 1030
AFG Afghanistan Asia Southern and... 652090.00 1919 2272
ACO Angola Africa Central Africa 1246700.00 1975 1287
AlA Anguilla North America  Caribbean 96.00 8000
ALB Albania Europe Southern Europe 28748.00 1912 3401
AND Andorra Europe Southern Europe 468.00 1278 7800
ANT Netherlands A... North America  Caribbean 800.00 2170
ARE United Arab E... Asia Middle East 83600.00 1971 2441
ARG Argentina South America  South America  2780400.00 1816 3703
ARM Armenia Asia Middle East 29800.00 1991 3520
ASM American Samoa Oceania Polynesia 199.00 6800
ATA Antarctica Antarctica Antarctica 13120000.00 1]
ATF French Southe... Antarctica Antarctica 7780.00 0
ATG Antigua and B... North America  Caribbean 442.00 1981 6800
AUS Australia QOceania Australia and... 7741220.00 1901 1888
AUT Austria Europe Western Europe 83839.00 1918 8091
} Object Info Session
St Country 1 Apply Revert
Action Output :
Time Action Response Duration / Fetch Time
Qs 12:40:35  drop schema “example_source " Changes applied
@ 6 12:40:40 drop schema "f; Changes applied
@7 12:40:45  drop schema “new_schema3’; Changes applied
D 8 12:41:48  Apply changes to phpbugsdb No changes detected
@ 9 12:44:08  drop schema "phpbugsdb”; Changes applied

The SQL Editor user interface has these main elements:

e Main Menu

e Toolbar

SQL Query Panel

» Sidebar

» Auto-completion (in the Main Menu)

The following sections describe each of these elements.

6.7.1. Main Menu

Main Tabsheets (Overview, Output, History, Snippets, Results)

When an SQL Editor tab is selected, the most important items on the main menu bar are the Query and

Edit menus.
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Query Menu
The Query menu features the following items:

» Execute (All or Selection): Executes all statements in the SQL Query area, or only the selected
statements.

» Execute Current Statement: Executes the current SQL statement.

» Explain (All or Selection): Describes all statements, or the selected statement.
» Explain Current Statement: Describes the current statement.

» Stop: Stops executing the currently running script.

* Reconnect to Server: Reconnects to the MySQL server.

* New Tab: Creates a duplicate of the current SQL Editor tab.

» Commit Transaction: Commits a database transaction.

» Rollback Transaction: Rolls back a database transaction.

» Refresh: Synchronizes with the live server and refreshes views such as the live Overview tabsheet.
» Commit Result Edits: Commits any changes you have made to the server.

» Discard Result Edits: Discards any changes you have made.

» Export Results: Exports result sets to a file. Selecting this option displays the Export Query Results to
File dialog. The dialog enables you to select which result set you wish to export, the file format (CSV,
HTML, XML), and the name and location of the output file. Then click Export to export the data.

Edit Menu

The Edit menu features the Format submenu. The Format submenu includes the following menu items that
are of importance when in SQL Editor mode:

» Beautify Query: Reformats the query selected in the query tab and lays it out in nicely indented fashion.
» UPCASE Keywords: Converts keywords to uppercase in the currently selected query in the query tab.
» lowercase Keywords: Converts keywords to lowercase in the currently selected query in the query tab.
 Indent Lines: Indents the lines selected in the query tab.

» Unindent Lines: Unindents the lines selected in the query tab.

» Un/Comment Selection: Comments the lines currently selected in the query tab. If the lines are already
commented, this operation removes the comments.

» Auto-complete: Triggers the auto-completion wizard. This is enabled (and triggered) by default, and can
be disabled with Preferences, SQL Editor, Automatically Start Code Completion. Auto-completion will
list functions, keywords, schema names, table names and column names.

Note
@ This feature was added in MySQL Workbench 5.2.41.
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6.7.2. Toolbar

The toolbar features buttons in two locations, in the main toolbar and within the SQL Editor itself. The SQL
Editor buttons are described below.

Figure 6.6. SQL Editor - Toolbar

From left to right, these buttons are:

e Open a SQL Script File: Loads a saved SQL script to be ready for execution. The script is displayed in
the SQL Query area.

e Save SQL Script to File: Saves the currently loaded SQL script to a file specified by the user.

» Execute SQL Script: Executes the selected portion of the query, or the entire query if nothing is
selected.

« Execute Current SQL script: Execute the statement under the keyboard cursor.
» Explain (All or Selection): Execute the EXPLAI N command on the query under the keyboard cursor.

» Stop the query being executed: Halts execution of the currently executing SQL script. Note: the
database connection will not be restarted, and open transactions will remain open.

e Toggle whether execution of SQL script should continue after failed statements: If the red
“breakpoint” circle is displayed, the script terminates on a statement that fails. If the button is depressed
so that the green arrow is displayed, execution continues past the failed code, possibly generating
additional result sets. In either case, any error generated from attempting to execute the faulty statement
is recorded in the Output tabsheet.

» Commit: Commits the current transaction. Note: All query tabs in the same connection share the same
transactions. To have independent transactions, a new connection must be opened.

* Rollback: Rolls back the current transaction. Note: All query tabs in the same connection share the
same transactions. To have independent transactions, a new connection must be opened.

» Toggle Auto-Commit Mode: If selected, each statement will be committed independently. Note: All
query tabs in the same connection share the same transactions. To have independent transactions, a
new connection must be opened.

» Beautify SQL: Beautify/reformat the SQL script.
* Find panel: Show the Find panel for the editor.

 Invisible characters: Toggle display of invisible characters, such as newlines, tabs, spaces.

6.7.3. SQL Query Panel

In this area, you can enter SQL statements directly. The statements entered can be saved to a file or
snippet for later use. At any point, you can also execute the statements you have entered.

To save a snippet of code entered into the SQL Query panel, click the Save SQL to Sni ppets Li st
icon in the Snippets panel, enter a name (optional), and click OK. The snippet can be inserted into the SQL
Query panel at any time by double-clicking the snippet in the SQL Snippets panel.
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Figure 6.7. SQL Editor - SQL Query Panel

[ -
movies

BE | ¥¥L OB OC < Q[

le SELECT name, code FROM Country;

100% *| 321

Filter: | QY < | Export: G
name code
Aruba ABW
Afghanistan AFG
Angola AGO
Anguilla AlA
Albania ALB
Andorra AND

Metherlands A... ANT
United Arab E... ARE

Argentina ARG
Armenia ARM
Country 4

Read Only

Executing a SELECT query will display the associated result set in the SQL View panel, directly below the
SQL Query panel. These cells are editable if MySQL Workbench is able to determine how, as for example
they are editable if a Primary or Unigue key exists within the result set. If not, MySQL Workbench will
display a "read-only" icon at the bottom-right corner of the SQL View panel, and hovering the mouse cursor
over this icon will provide a hint as to why it's not editable.

Note
@ To quickly enter the name of a table, view, or column, double-click the item in the
Schemata Palette. The item name will be inserted into the SQL Query panel.

6.7.4. Main Tabsheets

The main tabsheets area contains several tabs:
» Output and History Tabsheet

* Results Tabsheets

 Live Editing Tabsheet

Figure 6.8. SQL Editor - Main Tabsheets

Overview Qutput History Snippets Result (1) x
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The following sections describe each of these in more detail.
6.7.4.1. Output and History Tabsheet

The Output and History tabsheet is located at the bottom of MySQL Workbench, and can be toggled on or
off. It contains a select box that includes Acti on Qut put, Text Qut put, and Hi st ory options.

The Action Output tabsheet displays a summary of the communication between the script and the server.
The messages displayed can be information or errors. Each message displays the time, the action that
was carried out, and the response from the server. This output is useful for troubleshooting scripts.

The Text Output tabsheet will display a textual representation of the query, as displayed using the MySQL
Console. Use Query, Execute (All or Selection) to Text to send output to this tabsheet.

The History tabsheet provides a history of SQL operations carried out. The time and SQL code for each
operation is recorded. To view the SQL executed, click the time, and the SQL code executed will be
displayed in the SQL column.

6.7.4.2. Results Tabsheets

The results area of the screen shows the results from any queries that have been executed. If the script
contains multiple queries, a result tab will be generated for each query that returns results.

Figure 6.9. SQL Editor - Results Tabsheets

Overview Output History Snippets Result (1) =

Koo | B | |ﬁ EEL L R | Q Fetched 239 records =
name code i
Netherlands MNLD
Metherlands Antiles  ANT
Albania ALB
Algeria DZA
American 5amoa ASM
Andorra AND
Angola AGO
Anquilla ATA
Antigua and Barbuda  ATG
United Arab Emirates ARE
Argentina ARG
Armenia ARM -

Controls are provided to enable you to easily move over the results. These are shown in the following
screenshot.

Figure 6.10. SQL Editor - Results Tabsheets Navigation Controls

||1<:: @ ool |[B|EE || | Fetched 239 records =

From left to right, the controls are:
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* Move to first row: Highlights the first row in the current result set.

* Move to previous row: Highlights the previous row.

* Move to next row: Highlights the next row.

* Move to last row: Highlights the last row in the current result set.

e Toggle wrapping of cell contents: Toggles between truncating or wrapping the data in a cell.

» Sort Ascending: Sorts the selected column in ascending order.

» Sort Descending: Sorts the selected column in descending order.

» Export record set to an external file: Writes a result set to a CSV, HTML, or XML file as required.
» Refresh Data from Data Source: Refreshes the current result set from the data source.

» Search for substring within data: Searches the data for the string entered in the search box.

6.7.4.3. Live Editing Tabsheets

It is possible to edit data in real time using the Live Editing tabsheets. The live editor is the default view
type, so it will be displayed after running a SELECT query or by right-clicking a table in the Schema Viewer
and choosing Edit Data Table.

The top part of the result set may be resized to reveal the SELECT query that it originated from. This query
can be altered to show only columns you want, which might mean adding a WHERE clause.

In addition to the controls offered by the Results tabsheet, the Live Editor tab features some additional
controls. These controls are highlighted in the following screenshot.

Figure 6.11. SQL Editor - Live Editing Tabsheet Navigation Controls

Queryl:‘.
Bl 7FyrBe0on Bl <|a 1=

1® SELECT * FROM world.Country;

100% 4| 291

Filter: (Q, O | ediv g B B | Rile: Bp B
Code MNarme 'Continent 'Region SurfaceArea IndepYear Population LifeExpectancy CNP CNPOId
ABW Aruba North America Caribbean 193.00 103000 78.4 828.00 793.00
AFG Afghanistan Asia Southern and... 652090.00 1919 22720000 45.9 5976.00
AGO Angola Africa Central Africa  1246700.00 1975 12878000 38.3 6648.00 7984.00
AlA Anguilla North America Caribbean 96.00 8000 76.1 63.20
ALB Albania Europe Southern Europe 28748.00 1912 3401200 716 3205.00 2500.00
AND Andorra Europe Southern Europe 468.00 1278 78000 83.5 1630.00
ANT Netherlands A... North America Caribbean 800.00 217000 74.7 1941.00
ARE United Arab E... Asia Middle East 83600.00 1971 2441000 74.1 37966.00 36846.00
ARG Argentina South America South America 2780400.00 1816 37032000 75.1 340238.00 323310.00
ARM Armenia Asia Middle East 29800.00 1991 3520000 66.4 1813.00 1627.00
ASM American Samoa Oceania Polynesia 199.00 68000 75.1 334.00
ATA Antarctica Antarctica Antarctica 13120000.00 0 0.00
ATF French Southe... Antarctica Antarctica 7780.00 0 0.00
ATG Antigua and B... North America Caribbean 442,00 1981 68000 70.5 612.00 584.00
AUS Australia Oceania Australia and... 7741220.00 1901 18886000 79.8 351182.00 392911.00
AUT Austria Europe Western Europe 83859.00 1918 8091800 77.7 211860.00 206025.00
AZE Azerbaijan Asia Middle East B6600.00 1991 7734000 62.9 4127.00 4100.00
EDI Burundi Africa Eastern Africa  27834.00 1962 6695000 46.2 903.00 982.00
BEL Belgium Europe Western Europe 30518.00 1830 102338000 77.8 249704.00 243948.00
BEN Benin Africa Western Africa  112622.00 1960 6097000 50.2 2357.00 2141.00
Country 1 Apply Revert

Action Output =

Time Action Response Duration / Fetch Time
o 1 18:18:08 SELECT * FROM world.Country LIMIT 0, 1000 230 row(s) returned 0.000 sec / 0.001 sec
Query Completed
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These additional controls enable you to make changes other than simple edits, like inserting/removing
rows and exporting the data.

From left to right, the additional controls are:

» Edit current row: Enters edit mode for the currently selected row. Double-clicking a cell has the same
effect.

Note

@ It is possible to enter a function, or other expression, into a field. Use the prefix
\ f unc to prevent MySQL Workbench from escaping quotation marks. For
example, for the expression nd5("' fred' ), MySQL Workbench normally would
generate the code nd5(\ ' fred\"' ). To prevent this, enter the expression as
\func nd5("' fred') toensure that the quoting is not escaped.

» Insert new row: Inserts a new row and enables you to enter data. Your changes will not be reflected on
the live server until you click Apply changes to data.

» Delete selected rows: Removes the selected rows. Your changes will not be reflected on the live server
until you click Apply changes to data.

» Export recordset to an external file: Exports the result set as a file to a defined location. The same
as choosing Query, Export Results... from the main menu. Data may be exported as several formats,
including CSV, CSV (; separated), HTML, JSON, SQL, and XML.

» Import records from an external file: Imports data from a CSV file. Data is separated by a comma, and
not the alternative CSV (; separated) MySQL Workbench export option.

This feature was added in MySQL Workbench 5.2.45.

See also Section 7.7.1.3.8, “The Inserts Tab”.

6.7.5. Sidebar

The Sidebar contains these panels:
e Session (connection) Information
* Shippets

* Schemas

The following sections describe each panel in more detail.

6.7.5.1. Snippets panel

The Snippets sidebar offers both built-in and custom snippets. The sidebar contains a select box, with My
Snippets for custom snippets, and built-in options titted DB Mgmt (Database Management), SQL DDL
(SQL Data Definition Language), and SQL DML (SQL Data Manipulation Language).

Snippets may be given names, and these snippets can be viewed and edited from the Snippets sidebar. To
load a snippet into the SQL Query area, either choose the Snippets Insert icon or right-click on the desired
shippet and choose Insert. Double-click a snippet to open an edit context, to edit the snippet body or title.
This example shows two snippets, with only the first having defined a name.
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Figure 6.12. SQL Editor - Snippets Palette

Snippets

%ﬁ[ My Snippets :]1@%"%

7:% Select Stuff

SELECT name, code FROM Country;C...

6.7.5.2. Session and Object Information Panel

This panel summarizes the current connection to the server.
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Figure 6.13. SQL Editor - Connection Information Palette

Object Info | Session |

Connection:

Mame: localhost

Host: localhost

Fort: 3306

Server: MySQL

Version: 5.5.15-log

Login User: root

Current User: root@localhost

This panel also summarizes information about the object.

Figure 6.14. SQL Editor - Object Info

| Object Info | Session

Table: actor

Columns:

actor_jd smallint(5) UN PK Al
first_name varchar(45)
last_name  varchar(45)
last_update timestamp

6.7.5.3. Object Browser

The Object Browser contains an Actions list and a Schemata list, as seen in the following screenshot.
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Figure 6.15. SQL Editor - Object Browser

ACTIONS
¥ Execute SQL File
" Add Schema
B Add Table
[ Add View
¥ Add Routine

SCHEMAS
[ ;] test
[ ._1] world

Object Browser Actions List
The Object Browser contains an Actions list. The actions are:
» Execute SQL File: Opens a file chooser dialog that enables you to select an SQL script to execute.

» Add Schema: Enables you to add a new schema to your server.

Add Table: Enables you to create a new table via the new_table dialog.

Add View: Enables you to create a hew view via the new_view dialog.

Add Routine: Enables you to create a new routine via the new_routine dialog.
Schemata List

The Schemata list shows available schemata on the currently connected server. These can be explored to
show tables, views, and routines within the schema.
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Figure 6.16. SQL Editor - Schemata Explorer

SCHEMAS B
Q

[ dvd_collection
b (=] sakila
»  test
v [=] world
v [P Tables
v & City
¥ [ Columns
% ID
o Name
& CountryCode
& District
& Population
b5 Indexes
b [ Foreign Keys
pﬁl Triggers
» = Country
p = CountryLanguage
5 test
b 51 Views
» 51 Routines

It is possible to set a schema as the default schema by right-clicking the schema and selecting the Set

As Default Schema menu item. This executes a USE schena_nane statement so that subsequent
statements without schema qualifiers are executed against this schema. This setting applies only to

the query session. To set a default schema for multiple MySQL Workbench sessions, you must set the
default schema for the stored connection. From the Home screen, click Manage Connections, then in the
Manage DB Connection dialog, set the desired default schema on the Parameters tab.

A useful feature that was introduced in MySQL Workbench 5.2.9 is the ability to rapidly enter table, view,
or column names into the SQL Statement area. Double-clicking a table, view, or column name in the
schemata explorer inserts the name into the SQL Query area. This reduces typing significantly when
entering SQL statements containing references to several tables, views, or columns.

The Object Browser also features a context menu which can be displayed by right-clicking an object. For
example, right-clicking a table displays the following menu items:
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e Select Rows - Limit 1000: Pulls up to 1000 rows of table data from the live server into a Results
tabsheet.

» Edit Table Data: Pulls table data from the live server into a named tabsheet, and enables editing. Data
can be saved directly to the live server.

» Copy to Clipboard: There are various submenus, each of which copies information to the clipboard:
« Name (short): Copies the table name.
* Name (long): Copies the qualified table name in the form ~ schema™ . "tabl e".

e Column Names: Copies qualified column names the form "t abl e*. " col utm1™,
“table . colum2’,....

« Select All Statement: Copies a statement to select all columns in this form:

SELECT
“table’ . columl’,
“table’ . colum2’,

FRO\/I “schema’ . "table’;
 Insert Statement: Copies an | NSERT statement to insert all columns.
« Update Statement: Copies an UPDATE statement to update all columns.

» Delete Statement: Copies a DELETE statement in the form DELETE FROM "wor | d™ . “country’
WHERE <where_condition>;.

» Send to SQL Editor: Provides functionality similar to Copy to Clipboard. However, this item inserts the
SQL code directly into the SQL Query panel, where it can be edited further as required.

 Alter Table: Displays the table editor loaded with the details of the table.

» Create Table: Launches a dialog to enable you to create a hew table.

» Drop Table: Drops the table. All data in the table will be lost if this operation is carried out.
» Refresh All: Refreshes all schemata in the explorer by resynchronizing with the server.
Right-clicking an empty area inside the object browser displays the following menu items:

» Create Schema: Enables you to create a new schema on the connected server. You can apply your
changes to synchronize with the live server by clicking the Apply button.

» Refresh All: Synchronizes with the live server to update the information displayed by the schemata
explorer.
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Chapter 7. Data Modeling
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MySQL Workbench provides extensive capabilities for creating and manipulating database models,
including these:
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e Create and manipulate a model graphically

» Reverse engineer a live database to a model

» Forward engineer a model to a script or live database
» Create and edit tables and insert data

This is not an exhaustive list. The following sections discuss these and additional data-modeling
capablities.

The Home window is the typical starting point for work with data modeling. In the Data Modeling section
of the Workspace, you can use the action items there to create and manage models, forward and reverse
engineer, and compare and synchronize schemata:

* Open an Existing EER Model

» Create new EER Model

Create EER Model from Existing Database

Create EER Model from SQL Script

The following sections describe these action items.

7.1. Open an Existing EER Model

Clicking this action item launches a file browser. You can then select the model file you wish to load. A new
MySQL Model tab will then be created, and your model displayed.

If you have already created one or more model files, each will appear in this panel as an icon. Double-
clicking the item of the model you wish to load creates a new MySQL Model tab and displays your model.

If you already have created a connection to a database, it will appear in this panel as an icon. Double-
clicking the icon directly launches an SQL Editor tab, and connects you to the database as defined by the
connection.

To read more about modeling, see Section 7.5, “Model Editor”.

7.2. Create New EER Model

Clicking this action item launches a new MySQL Model tab, with a blank model ready for you to work on.

To read more about modeling, see Section 7.5, “Model Editor”.

7.3. Create EER Model from Existing Database

This action item enables you to create an EER Model from an existing live database. Clicking this action
item launches the Reverse Engineer Database. This is a multi-stage wizard that enables you to select a
connection to a live server, and select the schema and objects you wish to reverse engineer into your new
model. This is a convenient way to see how an existing database is structured.

For further information about reverse engineering, see Section 7.7.9.2, “Reverse Engineering a Live
Database”.

7.4. Create EER Model from SQL Script

This action item enables you to create a model from an SQL Create script. Such a script may have been
created by hand or as a result of reverse engineering an existing database. The script may then be

64



Model Editor

modified according to requirements. Clicking this action item launches the Reverse Engineer SQL Script
wizard. This is a multi-stage wizard that enables you to select the script you want to create your model
from.

For further information, see Section 7.7.9.1, “Reverse Engineering Using a Create Script”.

7.5. Model Editor

When the Model Editor is executed from the Home window, MySQL Workbench displays the MySQL
Model page. The MySQL Model page has three main panels, as shown in the following screenshot:
Description Editor, User Types List/History panel, and Model Overview.

Figure 7.1. The \ySQL Model Page
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The Description Editor and User Types List/History panel are contained within the Sidebar. The Sidebar
is located on the left by default, but can be relocated to the right using a setting in the Workbench
Preferences dialog.

The Model Overview panel has several sections:
» EER Diagrams

e Physical Schemata

* Schema Privileges

» SQL Scripts

Model Notes

For each of these sections, add objects to a project by clicking the appropriate add-object icon. You may
also rename, edit, cut, copy, or delete objects on this page by right-clicking to open a pop-up menu.

The following sections further discuss the MySQL Model page.

7.5.1. Modeling Menus

Some menu items are not available in the OSS version of this application, and are available only in the
Standard Edition. This is indicated where applicable.

7.5.1.1. The File Menu

Use the File menu to open a project, begin a new project, or save a project. Choosing New Model opens
the default schema, mydb. Choosing Open Model opens a file dialog box with the default file type set to
MySQL Workbench Models (mnb extension). To display a list of recently opened MWB files, choose the
Open Recent menu item. The keyboard shortcut to create a new project is Control+N and the command to
open an existing project is Control+0.

To close the currently active MySQL Model or EER Di agr amtab, use the Close Tab menu item. You
can also do this from the keyboard by pressing Control+W. To reopen the MySQL Mbdel tab, see
Section 7.5.1.3, “The View Menu”. To reopen an EER Di agr amtab, double-click the EER Di agr amicon
in the EER Di agr ans section of the MySQL Model page.

Use the Save Model or Save Model As menu items to save a model. When you save a model, its name
appeatrs in the title bar of the application. If you have made changes to a project and have not saved those
changes, an asterisk appears in the title bar following the model name. When you save a model, it is saved
as a MySQL Workbench file with the extension mab.

Use the Import menu item to import a MySQL data definition (DDL) script file. For example, this might be a
file created by issuing the command nysql dunp - - no- dat a. MySQL Workbench handles the script as
follows:

* If the script does not contain a CREATE DATABASE db_nane; statement, the schema objects are
copied to the default schema, mydb.

« If the script creates a database, a new tab bearing the database name is added to the Physi cal
Schenat a section of the MySQL Mbdel page.

« If the script contains data, the data is ignored.
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For details about importing a DDL script, see Section 7.7.9.1, “Reverse Engineering Using a Create Script”.
Under the Import submenu, you can also import DBDesi gner 4 files.

There are variety of items under the Export submenu. You may generate the SQL statements necessary
to create a new database or alter an existing one. For more information about these menu items, see
Section 7.7.10.1, “Forward Engineering Using an SQL Script”.

Using the Export submenu, you can also export an EER diagram as a PNG, SVG, PDF, or Postscript file.
For an example of a PNG file, see Figure 7.50, “The saki | a Database EER Diagram”.

The Page Setup menu item enables you to set the paper size, orientation, and margins for printing
purposes.

The printing options are enabled only if the EER Diagrams tab is selected. You have the choice of
printing your model directly to your printer, printing it as a PDF file, or creating a PostScript file. For more
information, see Section 7.9, “Printing”.

Note
@ The printing options are available only in commercial versions of MySQL
Workbench.

Use the Document Properties menu item to set the following properties of your project:
* Name: The model name (default is MySQL Model )

» Ver si on: The project version number

e Aut hor : The project author

» Proj ect: The project name

» Creat ed: Not editable; determined by the MWB file attributes

e Last Changed: Not editable; determined by the MWB file attributes

e Descri ption: A description of your project
7.5.1.2. The Edit Menu

Use the Edit menu to make changes to objects. The text description for several of the menu items changes
to reflect the name of the currently selected object.

This menu has items for cutting, copying, and pasting. These actions can also be performed using

the Control+X, Control+C, and Control+V key combinations. Undo a deletion using the Undo Delete
'obj ect _nane'item. The Control+Z key combination can also be used to undo an operation. It is also
possible to carry out a Redo operation using either the menu item, or the key combination Control+Y.

Also find a Delete 'obj ect _nane' menu item for removing the currently selected object. The keyboard
command for this action is Control+Delete. You can also right-click an object and choose the delete option
from the pop-up menu.

The Delete 'obj ect _nane' menu item behaves differently depending upon circumstances. For example,
if an EER Diagram is active and a table on the canvas is the currently selected object, a dialog box may
open asking whether you want to remove the table from the canvas only or from the database as well. For
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7.5.1.2.1.

information about setting the default behavior when deleting from an EER Diagram, see Section 5.4.4,
“The Model Tab”.

Warning
O If the M\ySQL Model page is active, the selected object is deleted from the catalog
and there will be no confirmation dialog box.

Choose Edit Selected to edit the currently selected object. You can also perform edits in a new window by
selecting Edit Selected in New Window. The keyboard shortcuts for Edit Selected and Edit Selected in New
Window are Control+E and Control+Shift+E, respectively.

The Select item has the following submenus:
» Select All (Keyboard shortcut, Control+A): Selects all the objects on the active EER diagram.
» Similar Figures (Objects of the same type): Finds objects similar to the currently selected object.

» Connected Figures: Finds all the objects connected to the currently selected object.

These menu items are active only when an EER Diagram tab is selected. The Similar Figures and the
Connected Figures menu items are disabled if no object is currently selected on an EER diagram.

When multiple objects have been selected using one of these menu items, you can navigate between
selected items by choosing the Go to Next Selected or Go to previous Selected menu item.

Selecting objects changes some of the Edit menu items. If only one object is selected, that object's name
appears after the Cut, Copy and Delete menu items. If more than one object is selected, these menu items
show the number of objects selected.

Find Dialog Window

Each MySQL Workbench window includes search functionality. The Find panel with Find & Replace
enabled is shown below:

68



Modeling Menus

Figure 7.2. The Find Panel with Find & Replace
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Find options

The Find dialogue options are described below:

 String Matching (default) or Regular Expression: Search by matching a string, or a PCRE regular

expression.

 Ignore Case: A case-insensitive search. Works with both the String Matching and Regular Expression
search methods. Enabled by default.

» Match Whole Words: If enabled, only whole strings are matched. For example, a search for "home"
would not match "home_id". Disabled by default.

» Wrap Around: The search will wrap around to the beginning of the document, as otherwise it will only

search from the cursor position to the end of the document. Enabled by default.

* And the arrows jump to the discovered search terms, and behave according to the Wrap Around option.

The Standard Edition of MySQL Workbench includes a more advanced Find facility:
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7.5.1.2.2.

Figure 7.3. The Find Window

Find Text: w
In Lacation: | Current Yiew bt
] Match Caze
[ whale word

] Use Regular Expressions
[] 5earch in Comments

[ Searchin SOL for Yiews, SPs etc

l Frevious l [ Mext ] I Find &ll

You can search the following locations:

» Entire Model: Searches the entire model.

» Current View: Searches the current view only. This may be the MySQL Mbdel page.

» All Views: Searches the MySQL Mbdel Page and all EER diagrams.

» Database Objects: Searches database objects only.

» Selected Figures: Searches the currently selected objects. This feature works only for EER diagrams.

Enter the text you wish to search for in the Find Text list. You may also select any or all of the following
check boxes:

» Match Case

Whole Word

» Use Regular Expression

» Search in Comments

» Search in SQL for Views, SPs etc.

Any text you enter into the Find Text list is retained for the duration of your session. Use the Next or
Previous buttons to find occurrences of your search criterion.

Clicking the Find All button opens a Find Results window anchored at the bottom of the application. If you
wish, you may undock this window as you would any other.

Use this window to navigate to objects. For example, double-clicking the Descr i pt i on of an object
located on an EER diagram navigates to the specific diagram and selects the object. Notice that the
properties of the object are displayed in the Pr operti es palette.

The Fi nd dialog window can also be opened using the Control+F key combination. Use Control+G to find
the next occurrence and Control+Shift+G to find a previous occurrence. Close the Fi nd dialog window by
clicking the x in the top right corner or by pressing the Esc key.

Workbench Preferences

This menu item enables you to set global preferences for the MySQL Workbench application.
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For further information, see Section 5.4, “Workbench Preferences”.

7.5.1.3. The View Menu

The View menu has these items:

Home: Selects the Home window

Windows: A submenu with items that provide a means for opening the windows associated with them:
* Model Navigator: Opens the Model Navi gat or palette

e Catalog: Opens the Cat al og palette

« Layers: Opens the Layer s palette

e User Datatypes: Opens the User Dat at ypes palette

* Object Descriptions: Opens the Descri pt i on palette

« Object Properties: Opens the Properti es palette

¢ Undo History: Opens the Hi st or y palette

Output: Displays the console output. The keyboard shortcut for this menu item is Control+F2.
Reset Window Layout: Resets all windows to their default layout

Zoom 100%: The default level of detail of an EER diagram

Zoom In: Zooms in on an EER diagram.

Zoom Out: Zooms out from an EER diagram.

The ability to zoom in on an EER diagram is also available using the slider tool in the Model
Navi gat or palette. See Section 7.5.9, “The Model Navigator Panel”.

Set Marker: Bookmarks an object. From the keyboard, select the object you wish to bookmark, then use
the key combination Control+Shift and the number of the marker (1 through 9). You may create up to
nine markers.

Go To Marker: Returns to a marker. From the keyboard, use the Control key and the number of the
marker.

Toggle Grid: Displays grid lines on an EER diagram.

Toggle Page Guides: Toggles Page Guides.

7.5.1.4. The Arrange Menu

The Arrange menu items apply only to objects on an EER diagram canvas and are enabled only if an EER
diagram view is active. The Arrange menu has these items:

Align to Grid: Aligns items on the canvas to the grid lines
Bring to Front: Brings objects to the foreground

Send to Back: Sends objects to the background
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Center Diagram Contents: Centers objects on the canvas

Autolayout: Automatically arranges objects on the canvas

Reset Object Size: Expands an object on an EER diagram. For example, if a table has a long column
name that is not fully displayed, this menu item expands the table to make the column visible. This menu
item is not enabled unless an object is selected.

Expand All: Use this item to expand all objects on an EER diagram. This item will display a table's
columns if the object notation supports expansion. Some object notations, such as Cl assi ¢, do not
permit expansion or contraction. Indexes will not automatically be expanded unless they were previously
expanded and have been collapsed using the Collapse All menu item.

Collapse All: Undo the operation performed by Expand All.

7.5.1.5. The Model Menu

7.5.1.5.1.

The Model menu has these items:

Add Diagram: Creates a new EER Diagram. The keyboard shortcut is Control+T.

Create Diagram From Catalog Objects: Creates an EER diagram from all the objects in the catalog.

DBDoc — Model Reporting...: For information about this menu item, see Section 7.5.1.5.1, “The DBDoc
Model Reporting Dialog Window (Commercial Version)”. Commercial version only.

User Defined Types: Presents a dialog box that enables you to add and delete user defined data types.

Object Notation: For information about this menu item, see Section 7.5.1.5.3, “The Object Notation
Submenu”.

Relationship Notation: For information about this menu item, see Section 7.5.1.5.4, “The Relationship
Notation Submenu”.

Diagram Properties and Size: Opens a diagram size dialog box that enables you to adjust the width or
height of the canvas. The unit of measure is pages; the default value is two.

When you have tables with numerous columns, use this menu item to increase the size of the EER.

Validation: For information about this menu item, see Section 7.5.1.5.2, “The Validation Submenus

(Commercial Version)”. Commercial version only.

Model Options: Sets options at the model level. These options should not be confused with the

options that are set globally for the Workbench application, and which are referred to as Workbench

Preferences. The available model options are a subset of the Workbench Preferences options.

For more information about Workbench Preferences, see Section 5.4.4, “The Model Tab”.

The DBDoc Model Reporting Dialog Window (Commercial Version)

This dialog window is found by navigating to the Model menu and choosing the DBDoc - Model Reporting...
item.

Note
@ The DBDoc - Model Reporting... item is not available in the MySQL Workbench

OSS version.
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7.5.1.5.2.

7.5.1.5.3.

Use this dialog window to set the options for creating documentation of your database models. For more
information, see Section 7.11, “The DBDoc Model Reporting Dialog Window (Commercial Version)”.

The Validation Submenus (Commercial Version)

The Model menu has two validation submenus, Validation and Validation (MySQL). Use these submenus
for general validation and MySQL-specific validation of the objects and relationships defined in your model.

Note
S These items are not available in the MySQL Workbench OSS version.

The Validation submenu has these items:

» Validate All: Performs all available validation checks

« Empty Content Validation: Checks for objects with no content, such as a table with no columns

» Table Efficiency Validation: Checks the efficiency of tables, such as a table with no primary key defined
» Duplicate Identifiers Validation: Checks for duplicate identifiers, such as two tables with the same name
« Consistency Validation: Checks for consistent naming conventions

* Logic Validation: Checks, for example, that a foreign key does not reference a nonprimary key column in
the source table

The Validation (MySQL) submenu has these items:
» Validate All: Performs all available validation checks

* Integrity Validation: Checks for invalid references, such as a table name longer than the maximum
permitted

» Syntax validation: Checks for correct SQL syntax
 Duplicate Identifiers Validation (Additions): Checks for objects with the same name

For detailed information about validation, see Section 7.10, “MySQL Workbench Schema Validation
Plugins (Commercial Version)”.

The Object Notation Submenu

The items under the Object Notation submenu apply exclusively to an EER diagram. They are not enabled
unless an EER diagram tab is selected.

The Object Notation submenu has these items:

» Workbench (Default): Displays table columns, indexes, and triggers

» Workbench (Simplified): Shows only a table's columns

* Classic: Similar to the Wor kbench (Si nplified) style showing only the table's columns
» IDEF1X: The ICAM DEFinition language information modeling style

The object notation style that you choose persists for the duration of your MySQL Workbench session and
is saved along with your model. When MySQL Workbench is restarted, the object notation reverts to the
default.
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first. Changing notation styles after objects have been placed on a diagram can
significantly change the appearance of the diagram.

Note
@ If you plan to export or print an EER diagram be sure to decide on a notation style

7.5.1.5.4. The Relationship Notation Submenu

The items under the Relationship Notation submenu apply exclusively to an EER diagram. They are not
enabled unless an EER diagram tab is selected.

The Relationship Notation submenu has these items:

Crow's Foot (IE): The default modeling style. For an example, see Figure 7.47, “Adding Tables to the
Canvas”.

Classic: Uses a diamond shape to indicate cardinality.
Connect to Columns
UML: Universal Modeling Language style.

IDEF1X: The ICAM DEFinition language information modeling method

To view the different styles, set up a relationship between two or more tables and choose the different
menu items.

The relationship notation style that you choose persists for the duration of your MySQL Workbench session
and is saved along with your model. When MySQL Workbench is restarted, the relationship notation
reverts to the default, the Cr ow s Foot style.

first. Changing notation styles after objects have been placed on a diagram can
significantly change the appearance of the diagram.

Note
@ If you plan to export or print an EER diagram, be sure to decide on a notation style

7.5.1.6. The Database Menu

The Database menu has these items:

Query Database: Launches the SQL Editor, which enables you to create SQL code and execute it on a
live server. For more information, see Section 6.7, “SQL Editor”.

Manage Connections: Launches the Manage DB Connections dialog, which enables you to create and
manage multiple connections. For more information, see Section 6.6, “Manage DB Connections Dialog

Reverse Engineer: Creates a model from an existing database. For more information, see
Section 7.7.9.2, “Reverse Engineering a Live Database”.

Forward Engineer: Creates a database from a model. For more information, see Section 7.7.10.2,
“Forward Engineering to a Live Server”.

Synchronize with Any Source: Allows you to compare a target database or script with the open model,
external script, or a second database, and apply these changes back to the target.

Synchronize Model: Synchronizes your database model with an existing database. For more information,
see Section 7.7.10.3, “Database Synchronization”.
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» Generate Catalog Diff Report; Compares your schema model with a live database or a script file.
Section 7.7.10.4, “Creating a Catalog Diff Report”.

7.5.1.7. The Plugins Menu

The Plugins menu lists any plugins that you may have installed. For more information about this menu, see
Section 11.3, “Plugins”.

7.5.1.8. The Scripting Menu

The Scripting menu has these items:
 Scripting Shell: Launches the MySQL Workbench Scripting Shell

» New Script: Opens a New Script File dialogue, with options to create a Python Script, Lua Script,
Python Plugin, or Python Module.

« Open Script: Opens a Open GRT Script dialogue, which defaults to the Workbench scripts directory.
Files are opened into the Workbench Scripting Shell window.

* Run Workbench Script File: Executes the specified script
« Install Plugin/Module File: Loads and installs a plugin or module file

» Plugin Manager: Displays information about the plugins that are are installed, and allows disabling and
uninstalling the plugins.

7.5.1.9. The Community Menu

7.5.1.10.

The Community menu has the following items. Use them to go online and learn more about MySQL
Workbench.

» Workbench Blog

* FAQs About Workbench

» Learn How To Code For Workbench
 Discuss Workbench Topics

+ Contribute To Workbench

The Help Menu

The Help menu has the following items. Use them to go online and learn more about MySQL Workbench.

» Help Index: Opens a window showing the MySQL Workbench documentation. Read, search, or print the
documentation from this window.

» MySQL.com Website: Opens your default browser on the MySQL Web site home page.
» Workbench Product Page: Opens your default browser on the MySQL Workbench product page.

» System Info: Displays information about your system, which is useful when reporting a bug. For more
information, see Section 7.5.1.10.1, “System Info”.

» Report a Bug: Opens a form to submit a bug to bugs.mysqgl.com, and optionally attaches the log file
to the report. Additional information such as the MySQL Workbench version, configuration and data

75



The Toolbar

directory paths, operating system, and more, are appended to the report but is made private so only
those with proper permissions (such as MySQL developers) can view this helpful debugging information.

» View Reported Bugs: Opens your default browser to see a list of current bugs.
* Locate log file: Opens up the directory that contains the MySQL Workbench log files.

e Check For Updates: Opens the MySQL Workbench website using your default browser, and checks for a
newer version.

» About Workbench: Displays the MySQL Workbench About window.
7.5.1.10.1. System Info

Use the System Info menu item to display information about your system. This item is especially useful for
determining your rendering mode. Sample output follows.

read_nysql _cfg_file C:\Program Files\MSQ\MSQ Server 5.1\ny.ini
[("tp_table_size', '9M),

'nmyi sam sort_buffer_size', '18M),

'tabl e_cache', '256'),

'read_rnd_buffer_size', '256K),

"port', '3306'), ('max_connections', '100'),

"innodb_buf fer_pool _size', '18M),

"nmyi sam max_sort_file_size', '100G),

"sqgl -npde', ' " STRI CT_TRANS_TABLES, NO AUTO_CREATE_USER, NO_ENG NE_SUBSTI TUTI ON"" ),
"basedir', '"C/ProgramFiles/ MWSQ./MWSQ Server 5.1/"'),
"defaul t-character-set', 'latinl'),

"datadir', '"C/ProgranbData/ MySQL/ MySQL Server 5.1/ Datal/"'),
"innodb_| og_buffer_size', '"1M),

"innodb_|l og_file_size', '10M),

"innodb_t hread_concurrency', '8'),

'read_buffer_size', '64K'),

"innodb_addi ti onal _mem pool _size', '2M),
"thread_cache_size', '8"),

"innodb_flush_log_at_trx_commt', '1'),

'query_cache_size', '0'),

"sort_buffer_size', '256K ),

"defaul t-storage-engine', '|INNODB'),

"key_buffer_size', '11M)]

MySQL Wor kbench OSS for W ndows version 5.2.8

Cairo Version: 1.8.6

Rendering Mode: GDI requested (create a diagramto confirm
OpenGL Driver Version: Not Detected

OS: unknown

CPU. Intel (R) Core(TM 2 Duo CPU T9300 @2.50GHz, 1.0 GB RAM
Vi deo adapter info:

Adapt er type: Virtual Box G aphi cs Adapter

Chi p Type: VBOX

BIOS String: Version OxBOC2 or |ater

Vi deo Menory: 12288 KB

NN AN AN AN A A A A A~ A A~

7.5.2. The Toolbar

The MySQL Workbench toolbar is located immediately below the menu bar. Click the tools in the toolbar to
perform the following actions:

* The new document icon: Creates a new document
» The folder icon: Opens a MySQL Workbench file (mib extension)

e The save icon: Saves the current MySQL Workbench project

76



EER Diagrams

e The right and left arrows: The left arrow performs an “Undo” operation. The right arrow performs a
“Redo” operation.

Other tools appear on the toolbar depending upon the context.

7.5.2.1. Tool-Specific Toolbar Items
When an EER diagram canvas is selected, the following icons appear to the right of the arrow icons:
e The toggle grid icon: Turns the grid on and off
» The grid icon: Aligns objects on the canvas with the grid
» The new EER diagram icon: Creates a new EER diagram tab.

The toolbar also changes depending upon which tool from the vertical toolbar is active. For discussion of
these tools, see Section 7.6.1, “The Vertical Toolbar”.

If the Tabl e tool is active, schemata lists, engine types, and collations appear on the toolbar. The table
properties can be modified using the Properties Editor.

When an object is selected, the object's properties, such as color, can be changed in the Properties Editor.

7.5.3. EER Diagrams

Use the Add new Di agr amicon in the MySQL Model area to create EER diagrams. When you add an
EER diagram, a new tab appears below the toolbar. Use this tab to navigate to the newly created EER
diagram. For further discussion of EER Diagrams, see Section 7.6, “EER Diagram Editor”.

7.5.4. The Physical Schemata Panel

The Physi cal Schenat a panel of the MySQL Model page shows the active schemata and the objects
that they contain.

Expand and contract the Physi cal Schemat a section by double-clicking the arrow on the left of the
Physi cal Schenat a title bar. When the Physi cal Schemat a section is expanded, it displays all
currently loaded schemata.

Each schema shows as a tab. To select a specific schema, click its tab. When MySQL Workbench is first
opened, a default schema, nydb, is selected. You can start working with this schema or you can load a
new MySQL Workbench Models file (mnb extensiona.)

There are a variety of ways to add schema to the Physi cal Schemnat a panel. You can open an
MWB file, reverse engineer a MySQL create script, or, if you are using a commercial version of MySQL
Workbench, you can reverse engineer a database by connecting to a MySQL server.

You can also add a new schema by clicking the + button on the top right of the Physi cal Schenat a
panel. To remove a schema, click its tab and use the - button found to the immediate left of the + button.
To the left of these buttons are three buttons that control how database object icons are displayed:

» The left button displays database objects as large icons.
» The middle button displays small icons in multiple rows.

» The right button displays small icons in a single list.
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7.5.4.1. The Schema Objects Panel

The Physi cal Schenat a panel has the following sections:
» Tables

* Views

* Routines

* Routine Groups
Each section contains the specified database objects and an icon used for creating additional objects.
Any database objects added to an EER diagram canvas also show up in the Physi cal Schenat a

section. For information about adding objects to an EER diagram canvas, see Section 7.6, “EER Diagram
Editor”.

7.5.5. The Schema Privileges Panel

The Scherma Pri vi | eges panel has the following sections, used to create users for your schemata and
to define roles —:

e Users

* Roles

The following image displays the Schena Pri vi | eges section of the MySQL Model tab.

Figure 7.4. Roles and Privileges

¥ Schema Privileges

Users (2 items

o Add User 3 raul 3§ stefan
Roles (2 tems

o Add Role ® admin ® docs

7.5.5.1. Adding Roles

To add a role, double-click the Add Rol e icon. This creates a role with the default name r ol el. Right-
clicking a role opens a pop-up menu with the following items:

* Cut'rol e_nane'": Cuts the role

» Copy rol e_nane'": Copies the role

 Edit Role...: Opens the role editor

» Edit in New Window...: Opens the role editor in a new editor window
» Delete 'r ol e_nane': Removes the role

e Copy SQL to Clipboard: Currently not implemented
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To rename a role, click the role name. Then you will be able to edit the text.

All roles that have been defined are listed under Rol es on the left side of the role editor. Double-clicking a
role object opens the role editor docked at the bottom of the page.

Figure 7.5. Role Editor

REFEREMNCES

7| INSERT

J| SELECT

| UPDATE
TRIGGER
LOOK TABLES

Rales

Select the role to which you wish to add objects. You may drag and drop objects from the Physi cal
Schenat a to the Obj ect s section of the role editor. To assign privileges to a role, select it from the

Rol es section, then select an object in the Cbj ect s section. In the Pri vi | eges section, check the rights
you wish to assign to this role. For example, a web_user role might have only SELECT privileges and only
for database objects exposed through a web interface. Creating roles can make the process of assigning
rights to new users much easier.

7.5.5.2. Adding Users

To add a user, double-click the Add User icon. This creates a user with the default name user 1. Double-
clicking this user opens the user editor docked at the bottom of the application.

Inthe User Edit or, setthe user's name and password using the Name and Password fields. Assign
one role or a number of roles to the user by selecting the desired roles from the field on the right and then
clicking the < button. Roles may be revoked by moving them in the opposite direction.

Right-clicking a user opens a pop-up menu. The items in the menu function as described in
Section 7.5.5.1, “Adding Roles”.

7.5.6. The SQL Scripts Panel
Use the SQL Scri pt s panel to load and modify SQL scripts. If you created your project from an SQL

script and plan to create an ALTER script, you may want to add the original script here, since it will be
needed to create an ALTER script. For more information, see Section 7.7.10.1.2, “Altering a Schema”.

7.5.7. The Model Notes Panel

Use the Mbdel Not es panel to write project notes. Any scripts or notes added will be saved with your
project.

7.5.8. The History Palette

Use the Hi st or y palette to review the actions that you have taken. Left-clicking an entry opens a pop-
up menu with the item, Copy History Entries to Clipboard. Choose this item to select a single entry. You
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can select multiple contiguous entries by pressing the Shift key and clicking the entries you wish to copy.
Select noncontiguous entries by using the Control key.

Only actions that alter the MySQL model or change an EER diagram are captured by the H st or y palette.

7.5.9. The Model Navigator Panel

Docked at the top left of the application is the Model Navigator, or Bird's Eye panel. This panel provides
an overview of the objects placed on an EER diagram canvas and for this reason it is most useful when an
EER diagram is active. Any objects that you have placed on the canvas should be visible in the navigator.

The Model Navigator shows the total area of an EER diagram. A black rectangular outline indicates the
view port onto the visible area of the canvas. To change the view port of an EER diagram, left-click this
black outline and drag it to the desired location. You can zoom in on selected areas of an EER diagram by
using the slider tool at the bottom of this window. The dimensions of the view port change as you zoom in
and out. If the slider tool has the focus, you can also zoom using the arrow keys.

The default size of the Model Navi gat or is two pages. To change this, use the Model menu, Diagram
Size menu item.

Figure 7.6. The Model Navigator Palette

3 00+

7.5.10. The Catalog Tree Palette

The Cat al og Tr ee palette shows all the schemata that are present in the Physi cal Schemat a section
of the M\ySQL Model page. Expand the view of the objects contained in a specific schema by clicking the +
button to the left of the schema name. This displays the following folder icons:

» Tables

* Views

* Routine Groups

Expand each of these in turn by clicking the + button to the left of the folder icon.

Selecting an object in this palette displays its properties in the Pr operti es palette, which can be found in
the lower left corner of the page.

The Catalog Tree palette is primarily used to drag and drop objects onto an EER diagram canvas.

generates a new selection. To drag multiple objects from the Catalog Tree to the

Note
@ On Linux, there is a quirk in the GTK tree control, where a simple click always
EER diagram canvas, you must perform the operation as follows:
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1. Click the first item in the tree.
2. Hold the Shift key, click the last item, and do not release the Shift key.
3. Keep the Shift key depressed and commence the dragging operation.

4. Release the Shift key before you release the mouse button to drop selected
objects onto the canvas.

This procedure also applies to use of the Control key when selecting multiple
nonadjacent elements in the Catalog Tree.

You can toggle the sidebar on and off using the Toggle Sidebar button, which is located in the top right of
the application.

7.5.11. The Layers Palette

This palette shows all the layers and figures that have been placed on an EER diagram. If a layer or figure
is currently selected, an X appears beside the name of the object and its properties are displayed in the
Properti es palette. This can be especially useful in determining which objects are selected when you
have selected multiple objects using the various options under the Select menu item. For more information
on this topic, see Section 7.5.1.2, “The Edit Menu”.

Selecting an object in the Layer s palette also adjusts the view port to the area of the canvas where the
object is located.

7.5.11.1. Finding Invisible Objects Using the Layers Palette

In some circumstances, you may want to make an object on an EER diagram invisible. Select the object
and, in the Pr operti es palette, set the vi si bl e property to Fal se.

The Layer palette provides an easy way to locate an object, such as a relationship, that has been set to
hi dden. Open the Layer s palette and select the object by double-clicking it. You can then edit the object
and change its visibility setting to Ful | y Vi si bl e.

7.5.12. The Properties Palette

The Pr operti es palette is used to display and edit the properties of objects on an EER diagram. It is
especially useful for editing display objects such as layers and notes.

All objects except connections have the following properties except as noted:

» col or: The color accent of the object, displayed as a hexadecimal value. Change the color of the object
by changing this value. Only characters that are legal for hexadecimal values may be entered. You can
also change the color by clicking the ... button to open a color changer dialog box.

e descri pti on: Applicable to layers only. A means of documenting the purpose of a layer.

» expanded: This attribute applies to objects such as tables that can be expanded to show columns,
indexes, and triggers.

» hei ght : The height of the object. Depending upon the object, this property may be read only or read/
write.

| ef t : The number of pixels from the object to the left side of the canvas.
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» | ocked: Whether the object is locked. The value for this attribute is either t r ue or f al se.

» manual Si zi ng: Whether the object has been manually sized. The value for this attribute is either t r ue
orfal se.

* nane: The name of the object.
« t op: The number of pixels from the object to the top of the canvas.

* Vi si bl e: Whether the object shows up on the canvas. Use * 1’ for true and * 0’ for false. It is currently
used only for relationships.

wi dt h: The width of the object. Depending upon the object, this property may be read only or read/write.

Tables have the following additional properties:

» i ndexesExpanded: Whether indexes are displayed when a table is placed on the canvas. Use * 1’ for
true and * 0’ for false.

» trigger sExpanded: Whether triggers are displayed when a table is placed on the canvas. Use * 1’ for
true and * O’ for false.

For a discussion of connection properties, see Section 7.7.2.3, “Connection Properties”.

7.6. EER Diagram Editor

EER diagrams are created by double-clicking the Add Di agr amicon. You may create any humber of EER
diagrams just as you may create any number of physical schemata. Each EER diagram shows as a tab
below the toolbar; a specific EER diagram is selected by clicking its tab.

Clicking an EER diagram tab navigates to the canvas used for graphically manipulating database objects.
The Vertical Tool bar is on the left side of this page.

7.6.1. The Vertical Toolbar

The vertical toolbar shows on the left sidebar when an EER diagram tab is selected. The tools on this
toolbar assist in creating EER diagrams.
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Figure 7.7. The Vertical Toolbar
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Clicking a tool changes the mouse pointer to a pointer that resembles the tool icon, indicating which tool is
active. These tools can also be activated from the keyboard by pressing the key associated with the tool.
Hover the mouse pointer over a toolbar icon to display a description of the tool and its shortcut key.

» CountryCode CHAR(3)

[

~| country v
Code CHAR(3)

»Name CHAR(52)

» Continent EMUM(...)

»Region CHAR(26)

» Surfacefrea FLOAT
IndepY ear SMALLINT (5}

» Population INT{11)
LifeExpectancy FLOAT
GNP FLOAT
GNPOId ALOAT

» LocdMame CHAR(45)

» GovernmentForm CHAR(45)
HeadOf tate CHAR{G0)
Capitd INT(11)

» Code2 CHAR(2)

A more detailed description of each of these tools follows.

7.6.1.1. The Standard Mouse Pointer

The standard mouse pointer, located at the top of the vertical toolbar, is the default mouse pointer for your

~| countrylanguage ¥
CountryCode CHAR(3)
Language CHAR(3D)

» IsOfficial ENUMCT', F)

» Percentage FLOAT

operating system. Use this tool to revert to the standard mouse pointer after using other tools.

To revert to the default pointer from the keyboard, use the Esc key.

7.6.1.2. The Hand Tool

m

The hand tool is used to move the entire EER diagram. Left-click on this tool and then left-click anywhere

on the EER diagram canvas. Moving the mouse while holding down the mouse button changes the view

port of the canvas.
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To determine your position on the canvas, look at the Model Navi gat or panel on the upper right. If the
Mbdel Navi gat or panel is not open, use View, Windows, Model Navigator to open it.

To activate the hand tool from the keyboard, use the H key.

You can also change the view port of an EER diagram using the Mbdel Navi gat or panel. See
Section 7.5.9, “The Model Navigator Panel”.

7.6.1.3. The Eraser Tool

Use the eraser tool to delete objects from the EER Diagram canvas. Change the mouse pointer to the
eraser tool, then click the object you wish to delete. Depending upon your settings, the delete dialog box
should open, asking you to confirm the type of deletion.

Note
@ The delete action of the er aser tool is controlled by the general option setting for
deletion. Before using the eraser tool, be sure that you understand the available
options described in Section 5.4.4, “The Model Tab”.
To activate the eraser tool from the keyboard, use the D key.

You can also delete an object by selecting it and pressing Control+Delete or by right-clicking it and
choosing Delete from the pop up menu.

7.6.1.4. The Layer Tool

The layer tool is the rectangular icon with a capital L in the lower left corner. Use the layer tool to organize
the objects on an EER Diagram canvas. It is useful for grouping similar objects. For example, you may use
it to group all your views.

Click the layer tool and use it to draw a rectangle on the canvas. Change to the standard mouse pointer
tool and pick up any objects you would like to place on the newly created layer.

To change the size of a layer, first select it by clicking it. When a layer is selected, small rectangles appear
at each corner and in the middle of each side. Adjust the size by dragging any of these rectangles.

You can also make changes to a layer by selecting the layer and changing properties in the Pr operti es
panel. Using the Pr operti es panel is the only way to change the name of a layer.

To activate the layer tool from the keyboard, use the L key. For more information about layers, see
Section 7.7.5, “Creating Layers”.

7.6.1.5. The Text Tool

The text tool is the square icon with a capital N in the top left corner. Use this tool to place text objects on
the EER diagram canvas. Click the tool, then click the desired location on the canvas. After a text object
has been dropped on the canvas, the mouse pointer reverts to its default.

To add text to a text object, right-click the text object and choose Edit Note... or Edit in New Window... from
the pop-up menu.

You can manipulate the properties of a text object by selecting it and then changing its properties in the
Properti es panel.

To activate the text tool from the keyboard, use the N key. For more information about text objects, see
Section 7.7.7, “Creating Text Objects”.
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7.6.1.6. The Image Tool

Use the image tool to place an image on the canvas. When this tool is selected and you click the canvas, a
dialog box opens enabling you to select the desired graphic file.

To activate the image tool from the keyboard, use the | key. For more information about images, see
Section 7.7.8, “Creating Images”.

7.6.1.7. The Table Tool

Use this tool to create a table on the EER Diagram canvas.

Clicking the canvas creates a table. To edit the table with MySQL Table Editor, right-click it and choose
Edit Table... or Edit in New Window... from the pop-up menu. You can also double-click the table to load it
into the table editor.

To activate the table tool from the keyboard, use the T key.

For more information about creating and editing tables, see Section 7.7.1.3, “The MySQL Table Editor”.

7.6.1.8. The View Tool

Use this tool to create a view on an EER Diagram canvas. When the table tool is activated, a schema

list appears on the toolbar below the main menu, enabling you to associate the new view with a specific
schema. You can also select a color for the object by choosing from the color list to the right of the schema
list.

After selecting this tool, clicking the canvas creates a new view. To edit this view, right-click it and choose
Edit View... or Edit in New Window... from the pop-up menu.

To activate the view tool from the keyboard, use the V key.

For more information about creating and editing views, see Section 7.7.3, “Creating Views”.

7.6.1.9. The Routine Group Tool

7.6.1.10.

Use this tool to create a routine group on the EER Diagram canvas. When this tool is activated, a schema
list appears on the toolbar below the main menu, enabling you to associate the routine group with a
specific schema. You can also select a color for the routine group by choosing from the color list to the
right of the schema list.

After selecting this tool, clicking the canvas creates a new group. To edit this view, right-click it and choose
Edit Routine Group... or Edit in New Window... from the pop-up menu.

To activate the routine group tool from the keyboard, use the G key.

For more information about creating and editing routine groups, see Section 7.7.4.2, “Routine Groups”.
The Relationship Tools

The five relationship tools are used to represent the following relationships:

» One-to-many nonidentifying relationships

« One-to-one nonidentifying relationships

» One-to-many identifying relationships

» One-to-one identifying relationships

» Many-to-many identifying relationships
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These tools appear at the bottom of the vertical tool bar. Hover the mouse pointer over each tool to see a
text hint that describes its function.

For more information about relationships, see Section 7.7.2, “Creating Foreign Key Relationships”.

7.7. Working with Models

7.7.1. Creating Tables
7.7.1.1. Adding Tables to the Physical Schemata

Double-clicking the Add t abl e icon in the Physi cal Schemat a section of the MySQL Mbdel page
adds a table with the default name of t abl el. If a table with this name already exists, the new table is
named t abl e2.

Adding a new table automatically opens the table editor docked at the bottom of the application. For
information about using the table editor, see Section 7.7.1.3, “The MySQL Table Editor”.

Right-clicking a table opens a pop-up menu with the following items:
e Cut'tabl e _nange'

» Copy 't abl e_nan®'

» Edit Table...

» Editin New Window...

e Copy SQL to Clipboard

» Copy Insert to Clipboard: Copies | NSERT statements based on the model's inserts. Nothing is copied to
the clipboard if the table has no inserts defined.

» Copy Insert Template to Clipboard: Copies a generic | NSERT statement that is based on the model.
* Delete 't abl e_nane’

If the table editor is not open, the Edit Table... item opens it. If it is already open, the selected table
replaces the previous one. Edit in New Window... opens a new table editor tab.

The cut and copy items are useful for copying tables between different schemata.

Warning
O Use the Delete 't abl e_nane' item to remove a table from the database. There will
be no confirmation dialog box.

Any tables added to the Physi cal Schemnat a section also show up in the Cat al og palette on the right
side of the application. They may be added to an EER Diagram by dragging and dropping them from this
palette.

7.7.1.2. Adding Tables to an EER Diagram

Tables can also be added to an EER Diagram using the t abl e tool on the vertical toolbar. Make sure that
the EER Diagram tab is selected, then right-click the table icon on the vertical toolbar. The table icon is the
rectangular tabular icon.

Clicking the mouse on this icon changes the mouse pointer to a table pointer. You can also change the
mouse pointer to a table pointer by pressing the T key.
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Choosing the t abl e tool changes the contents of the toolbar that appears immediately below the menu
bar. When the Tabl es pointer is active, this toolbar contains a schemata list, an engines list, a collations
list, and a color chart list. Use these lists to select the appropriate schema, engine, collation, and color
accent for the new table. Make sure that you associate the new table with a database. The engine and
collation of a table can be changed using the table editor. The color of your table can be changed using
the Properti es palette. The Def aul t Engi ne and Def aul t Col | at i on values refer to the database
defaults.

Create a table by clicking anywhere on the EER Diagram canvas. This creates a new table with the default
name t abl el. To revert to the default mouse pointer, click the arrow icon at the top of the vertical toolbar.

Figure 7.8. A Table on an EER Diagram

" | address v
address_id SMALLIMT(S)

& address WARCHAR(SO)

¢ addressZ WARCHAR(SD)

& district WARCHARZ0)

% city_id SMALLINT(S)

¢ postal_code WARCHAR{1O)

& phone WARCHARZ0)

¢ last_updake TIMESTAMP

v

FRIMARY
idw_Fk_city_id

As shown in the preceding diagram, the primary key is indicated by a key icon and indexed fields are
indicated by a different colored diamond icon. Click the arrow to the right of the table name to toggle the
display of the fields. Toggle the display of indexes and triggers in the same way.

Right-clicking a table opens a pop-up menu with the following items:
e Cut'tabl e _nange’

* Copy 't abl e_nane’

» Edit Table...

» Editin New Window...

» Copy SQL to Clipboard

» Copy Insert to Clipboard

» Delete 't abl e_nane'

With the exception of the deletion item, these menu items function as described in Section 7.7.1.1, “Adding
Tables to the Physical Schemata”. The behavior of the delete option is determined by your MySQL
Workbench options settings. For more information, see Section 5.4.4, “The Model Tab”.

7.7.1.3. The MySQL Table Editor

The MySQL Table Editor is a component that enables the creation and modification of tables. You can add
or modify a table's columns or indexes, change the engine, add foreign keys, or alter the table's name.

The MySQL Table Editor can be accessed in several ways, and most commonly by right-clicking on a
table name within the Object Viewer and choosing ALTER TABLE. This will open a new tab within the
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main SQL Editor window. You can also access the MySQL Table Editor from an EER Diagram by double-
clicking a table object.

7.7.1.3.1. The Main Editor Window

Any number of tables may be edited in the MySQL Table Editor at any one time. Adding another table
creates a new tab at the top of the editor. By default, the MySQL Table Editor appears docked at the top of
the table editor tab, within the SQL editor..

The MySQL Table Editor is shown on top of the following figure.

Figure 7.9. The Table Editor
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The MySQL Table Editor provides a work space that has tabs used to perform these actions:
e Columns: Add or modify columns

» Indexes: Add or modify indexes

» Foreign Keys: Add or modify foreign keys

» Triggers: Add or modify triggers

» Partitioning: Manage partitioning

e Options: Add or modify various general, table, and row options
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The following sections discuss these tabs in further detail.
7.7.1.3.2. The Columns Tab

Use the Columns tab to display and edit all the column information for a table. With this tab, you can add,
drop, and alter columns.

You can also use the Columns tab to change column properties such as hame, data type, and default
value.

Figure 7.10. The Columns Tab

Columns
Column Name Datatype PK NN UQ BIN UN ZF Al Default
customer_id SMALLINT(S) FEOD B
# store_id TINYINT(3) L O O O O 3 O sl
first_name WVARCHAR(45) il
» last_name VARCHAR(45) ¥
email VARCHAR(50) i ] O O i
+ address_id SMALLINTIS) ¥ | o
» active TINYINT(1) ] | [} 1
create_date DATETIME il L O |
» last_update TIMESTAMP & [ CURRENT_TIMESTA
Column Name: Data Type:
Collation: | Table Default Default:
Comments: " /| Primary Kay [¥] Mot b V] Unique
| Binary [¥] Unsigned (V] ZeroFill
= | Auto Increment
(I LI Indexes Foreign Keys Triggers Partitioning  Options

Right-click a row under the Col unm Nane column to open a pop-up menu with the following items:

» Move Up: Move the selected column up.

» Move Down: Move the selected column down.

» Copy: Copies the column for a model. Added in MySQL Workbench 5.2.45.

» Cut: Copies and then deletes the column for a model. Added in MySQL Workbench 5.2.45.

» Paste: Pastes the column. If a column with the same name already exists, then _copy1 is appended to
the column name. Added in MySQL Workbench 5.2.45.

* Delete Selected Columns: Select multiple contiguous columns by right-clicking and pressing the Shift
key. Use the Control key to select noncontiguous columns.

» Refresh: Update all information in the Columns tab.
» Clear Default: Clear the assigned default value.

o Default NULL: Set the column default value to NULL.
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+ Default 0: Set the column default value to O.
* Default CURRENT_TIMESTAMP: Available for TI MESTANP data types.

e Default CURRENT_TIMESTAMP ON UPDATE CURRENT_TIMESTAMP: Available for TI MESTAMP data
types.

To add a column, click the Col urm Nane field in an empty row and enter an appropriate value. Select a
data type from the Datatype list. Select the column property check boxes as required according to the list
of column properties below, and also read the CREATE TABLE documentation for information about what
these options mean.

* PK: PRIMARY KEY

* NN: NOT NULL

* UQ: UNIQUE INDEX

* BIN: BINARY

* UN: UNSIGNED

* ZF: ZEROFILL

* Al: AUTO_INCREMENT

To change the name, data type, default value, or comment of a column, double-click the value you wish to
change. The content then becomes editable.

You can also add column comments to the Col unm Conment field. It is also possible to set the column
collation, using the list in the Column Details panel.

To the left of the column name is an icon that indicates whether the column is a member of the primary
key. If the icon is a small key, that column belongs to the primary key, otherwise the icon is a blue diamond
or a white diamond. A blue diamond indicates the column has NN set. To add or remove a column from the
primary key, double-click the icon. You can also add a primary key by checking the PRI MARY KEY check
box in the Col umm Det ai | s section of the table editor.

If you wish to create a composite primary key you can select multiple columns and check the PK check
box. However, there is an additional step that is required, you must click the Indexes tab, then in the Index
Columns panel you must set the desired order of the primary keys.

Workbench will attempt to automatically add quotation marks, if the user does not
start their entry with one. For other data types the user must manage quoting if

Note
@ When entering default values, in the case of CHAR and VARCHAR data types MySQL
required, as it will not be handled automatically by MySQL Workbench.

Caution

A Care must be taken when entering a default value for ENUMcolumns because
a nonnumeric default will not be automatically quoted. You must manually add
single quote characters for the default value. Note that MySQL Workbench will not
prevent you from entering the default value without the single quotation marks. If a
nonnumeric default value is entered without quotation marks, this will lead to errors.
For example, if the model is reverse engineered, the script will contain unquoted
default values for ENUMcolumns and will fail if an attempt is made to run the script
on MySQL Server.
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7.7.1.3.3. The Indexes Tab
The Indexes tab holds all index information for your table. Use this tab to add, drop, and modify indexes.

Figure 7.11. The Indexes Tab

SQL File 1 address

. Table Name: }ad&“‘s | Schema: sakila
i L4
e Collation: | utf - default collation v| Engne: [InnoDe -
Comments:
Indexes
Index Mame Type Index Columns Index Options
PRIMARY PRIMARY Storage Type: -
idx_fk_city_id INDEX Column # Order  Length
|| address_id 1 ASC Key Block Size: 0
[ address ASC —_—
| address2 ASC Lot
L distr?ﬁ ASC Index ~
| city_id ASC
[[] postal_code ASC -
[[] phone ASC
[[] 1ast_update ASC
[7] fafaf ASC

Columns Foreign Keys Triggers Partitioning Options

Select an index by right-clicking it. The Index Columns section displays information about the selected
index.

To add an index, click the last row in the index list. Enter a name for the index and select the index type
from the list. Select the column or columns that you wish to index by checking the column name in the
Index Columns list. You can remove a column from the index by removing the check mark from the
appropriate column.

You can also specify the order of an index by choosing ASC or DESC under the Or der column. Create an
index prefix by specifying a numeric value under the Lengt h column. You cannot enter a prefix value for
fields that have a data type that does not support prefixing.

To drop an index, right-click the row of the index you wish to delete, then select the Delete Selected
Indexes menu item.
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7.7.1.3.4.

7.7.1.3.5.

The Foreign Keys Tab

The Foreign Keys tab is organized in much the same fashion as the Indexes tab and adding or editing a
foreign key is similar to adding or editing an index.

Figure 7.12. The Foreign Keys Tab

Foreign Keys
Foreign Key Name Referenced Table Column Referenced Column » Foreign Key Options
fk_customer_address “sakila”." address’ On Update:

fk_customer_store “sakila®. store’
- = On Delete:

= | -Foreign Key Comment

Columns Indexes WEICHLLNCN Triggers Partitioning Options

To add a foreign key, click the last row in the For ei gn Key Nane list. Enter a name for the foreign key
and select the column or columns that you wish to index by checking the column name in the Column list.
You can remove a column from the index by removing the check mark from the appropriate column.

Under Foreign Key Options, choose an action for the update and delete events. The options are:

RESTRICT

CASCADE

SET NULL

NO ACTION

To drop a foreign key, right-click the row you wish to delete, then select the Delete Selected FKs menu
item.

To modify properties of a foreign key, select it and make the desired changes.
The Triggers Tab

The Triggers tab opens a field for editing an existing trigger or creating a new trigger. Create a trigger as
you would from the command line.
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Figure 7.13. The Triggers Tab

Columns Indexes Foreign Keys

Triggers
1 - Trigger DDL Statements
2 DELIMITER $§%
3
4 ® USE “sakila’ss
5
E e CREATE
7 DEFINER=" root @ localhost”
8 TRIGGER “sakila’. customer_create_date”
9 BEFORE INSERT ON “sakila™. customer’
10 FOR EACH ROW
11 SET NEW.create_date = NOW()ss
12
13

(Ul-EM Partitioning  Options

7.7.1.3.6. The Partitioning Tab

To enable partitioning for your table, check the Enable Partitioning check box. This enables the

partitioning options.
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Figure 7.14. The Partitioning Tab

Partitioning
[ Enable Partiioning
Parfition By: Parameters: Partition Count:
Subpartition By: Parameters: Subpartition Count:
Partition Valses Data Directory Index Directory Mim Rows  Max Rows Comment =

Columns Indexes Foreign Keys Triggers JElddtLILGLE Options

The Partition By pop-up menu displays the types of partitions you can create:

HASH

LINEAR HASH
KEY

LINEAR KEY
RANGE

LIST

Use the Parameters field to define any parameters to be supplied to the partitioning function, such as an
integer column value.

Choose the number of partitions from the Partition Count list. To manually configure your partitions, check
the Manual check box. This enables entry of values into the partition configuration table. The entries in this
table are:

Partition

Val ues

Data Directory
I ndex Directory

M n Rows
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e Max Rows

e Comment
Subpatrtitioning is also available. For more information about partitioning, see Partitioning.
7.7.1.3.7. The Options Tab

The Options tab enables you to set several types of options.

Figure 7.15. The Options Tab
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Table Password:
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Storage Options
Data Directory:
Index Directory:

Merge Table Options
Union Tables:

Merge Method: | Don't Use -

Columns Indexes Foreign Keys Triggers Partitioning gEeed]t

which are grouped into the following sections:

General Options

* Row Options

Storage Options

Merge Table options
The following discussion describes these options in more detail.

General Options Section
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7.7.1.3.8.

In the General Options section, choose a pack keys option. The options are Def aul t , Pack None, and
Pack All.You may also encrypt the definition of a table. The AUTO | NCREMENT and delayed key update
behaviors apply only to Myl SAMtables.

Row Options Section

To set the row format, choose the desired row format from the list. For more information about the different
row formats that are available, see Myl SAMTable Storage Formats.

These options are:
» Default

* Dynamic

» Fixed

e Compressed

* Redundant

» Compact

When you expect a table to be particularly large, use the Avg. Row, Min. Rows, and Max. Rows options
to enable the MySQL server to better accommodate your data. See CREATE TABLE Syntax for more
information on how to use these options.

Storage Options Section

The St or age Opt i ons section is available only for Myl SAMtables. Use it to configure a custom path to
the table storage and data files. This can help improve server performance by locating different tables on
different hard drives.

Merge Table Options Section

Use the Mer ge Tabl e Options section to configure MERGE tables. To create a MERGE table, select VERGE
as your storage engine and then specify the Myl SAMtables you wish to merge in the Union Tables dialog.

You may specify the action the server should take when users attempt to perform | NSERT statements on
the merge table. You may also select the Mer ge Met hod by selecting from the list. For more information
about VERGE tables, see The MERCE Storage Engine.

The Inserts Tab
Use the Inserts tab to insert rows into the table.

To edit a row, click the field you wish to change and enter the new data. Right-clicking a row displays a
menu with the following items:

e Set Field(s) to NULL: Set the column value to NULL.
» Delete Row(s): Delete the selected row or rows.

» Copy Row Content: Copies the row to the clipboard. Strings are copied quoted, and NULL values are
preserved.

e Copy Row Content (unquoted): Copies the row to the clipboard. Strings are not quoted and NULL are
copied as a space.
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» Copy Field Content: Copies the value of the selected field to the clipboard. Strings are quoted.

» Copy Field Content (unquoted): Copies the value of the selected field to the clipboard. Strings are not
quoted.

Note that the insert editor features a toolbar. This has the same functionality as explained in
Section 6.7.4.2, “Results Tabsheets” and Section 6.7.4.3, “Live Editing Tabsheets”. You can also hover the
cursor over the toolbar to display tooltips.

Any rows you add will be inserted when you forward engineer the database (if you choose the Gener at e
| NSERT statenments for tabl es option).

Note
@ When entering string values that there is slightly different behavior between the 5.0,
5.1, and 5.2 versions of MySQL Workbench.

For 5.0 and 5.1, if a string is entered without leading and trailing quotation marks,
the Inserts Editor adds quoting and escapes characters that require it. However, if
guoted text is entered, the Inserts Editor performs no further checks and assumes
that a correctly escaped and quoted sequence has been entered.

5.2 features a new Inserts Editor. In this case, the user enters the string without
guoting or escaping and the Inserts Editor takes care of all quoting and escaping as
required.

\ f unc to prevent MySQL Workbench from escaping quotation marks. For example,
for the expression nd5( "' fred' ), MySQL Workbench normally would generate
the code nd5(\"' fred\"' ). To prevent this, enter the expression as \ f unc

Note
@ It is possible to enter a function, or other expression, into a field. Use the prefix
nd5(" fred' ) to ensure that the quoting is not escaped.

7.7.1.3.9. The Privileges Tab

Use the Privileges tab to assign specific roles and privileges to a table. You may also assign privileges to
a role using the role editor. For a discussion of this topic, see Section 7.5.5.1, “Adding Roles”.

When this tab is first opened, all roles that have been created are displayed in the list on the right. Move
the roles you wish to associate with this table to the Roles list on the left. Do this by selecting a role and
then clicking the < button. Use the Shift key to select multiple contiguous roles and the Control key to
select noncontiguous roles.

To assign privileges to a role, click the role in the Roles list. This displays all available privileges in the
Assigned Privileges list. The privileges that display are:

* ALL
* CREATE
» DRCP

* GRANT OPTI ON

REFERENCES

ALTER
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 DELETE

* | NDEX

| NSERT

SELECT
* UPDATE
* TRI GGER

You can choose to assign all privileges to a specific user or any other privilege as listed previously.
Privileges irrelevant to a specific table, such as the FI LE privilege, are not shown.

If a role has already been granted privileges on a specific table, those privileges show as already checked
in the Assigned Privileges list.

7.7.2. Creating Foreign Key Relationships

Foreign key constraints are supported for the | nnoDB storage engine only. For other storage engines,
the foreign key syntax is correctly parsed but not implemented. For more information, see Foreign Key
Differences.

Using MySQL Workbench you may add a foreign key from within the table editor or by using the
relationship tools on the vertical toolbar of an EER Diagram. This section deals with adding a foreign key
using the foreign key tools. To add a foreign key using the table editor, see Section 7.7.1.3.4, “The Foreign
Keys Tab".

The graphical tools for adding foreign keys are most effective when you are building tables from the ground
up. If you have imported a database using an SQL script and need not add columns to your tables, you
may find it more effective to define foreign keys using the table editor.

7.7.2.1. Adding Foreign Key Relationships Using an EER Diagram
The vertical toolbar on the left side of an EER Diagram has six foreign key tools:
* one-to-one non-identifying relationship
* one-to-many non-identifying relationship
* one-to-one identifying relationship
* one-to-many identifying relationship
e many-to-many identifying relationship
« Place a Relationship Using Existing Colums

An identifying relationship is one where the child table cannot be uniquely identified without its parent.
Typically this occurs where an intermediary table is created to resolve a many-to-many relationship. In
such cases, the primary key is usually a composite key made up of the primary keys from the two original
tables. An identifying relationship is indicated by a solid line between the tables and a nonidentifying
relationship is indicated by a broken line.

Create or drag and drop the tables that you wish to connect. Ensure that there is a primary key in the table
that will be on the “one” side of the relationship. Click on the appropriate tool for the type of relationship you
wish to create. If you are creating a one-to-many relationship, first click the table that is on the “many” side
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of the relationship, then on the table containing the referenced key. This creates a column in the table on
the many side of the relationship. The default name of this column is t abl e_nane_key nane where the
table name and the key name both refer to the table containing the referenced key.

When the many-to-many tool is active, double-clicking a table creates an associative table with a many-to-
many relationship. For this tool to function there must be a primary key defined in the initial table.

Use the Model menu, Menu Options menu item to set a project-specific default name for the foreign key
column (see Section 7.5.1.5.4, “The Relationship Notation Submenu”). To change the global default, see
Section 5.4.4, “The Model Tab".

To edit the properties of a foreign key, double-click anywhere on the connection line that joins the two
tables. This opens the relationship editor.

Mousing over a relationship connector highlights the connector and the related keys as shown in the
following figure. The fi | mand the fi | m act or tables are related onthe fi | m_i d field and these fields
are highlighted in both tables. Since the fi | m_ i d field is part of the primary key inthe fi | m_act or table,
a solid line is used for the connector between the two tables.

Figure 7.16. The Relationship Connector
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If the placement of a connection's caption is not suitable, you can change its position by dragging it to

a different location. If you have set a secondary caption, its position can also be changed. For more
information about secondary captions, see Section 7.7.2.3, “Connection Properties”. Where the notation
style permits, Cl assi ¢ for example, the cardinality indicators can also be repositioned.

The relationship notation style in Figure 7.16, “The Relationship Connector” is the default, crow's foot. You
can change this if you are using a commercial version of MySQL Workbench. For more information, see
Section 7.5.1.5.4, “The Relationship Notation Submenu”.

You can select multiple connections by holding down the Control key as you click a connection. This can
be useful for highlighting specific relationships on an EER diagram.

7.7.2.2. The Relationship Editor

Double-clicking a relationship on the EER diagram canvas opens the relationship editor. This has two tabs:
Relationship, and Foreign Key.
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The Relationship Tab

In the Relationship tab, you can set the caption of a relationship using the Caption field. This name
displays on the canvas and is also the name used for the constraint itself. The default value for this name
isfk source_table destination_table.Usethe Model menu, Menu Options menu item to set a
project-specific default name for foreign keys. To change the global default, see Section 5.4.4, “The Model
Tab".

You can also add a secondary caption and a caption to a relationship.

The Visibility Settings section is used to determine how the relationship is displayed on the EER Diagram
canvas. Ful | y Vi si bl e is the default but you can also choose to hide relationship lines or to use split
lines. The split line style is pictured in the following figure.

Figure 7.17. The Split Connector
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@ A broken line connector indicates a nonidentifying relationship. The split line style
can be used with either an identifying relationship or a nonidentifying relationship. It
is used for display purposes only and does not indicate anything about the nature of
a relationship.

To set the notation of a relationship use the Model menu, Relationship Notation menu item. For more
information, see Section 7.5.1.5.4, “The Relationship Notation Submenu”.

The Foreign Key Tab
The Foreign Key tab contains several sections: Referencing Table, Cardinality and Referenced Table.

The Mandatory check boxes are used to select whether the referencing table and the referenced table are
mandatory. By default, both of these constraints are t r ue (indicated by the check boxes being checked).

The Cardinality section has a set of radio buttons that enable you to choose whether the relationship is
one-to-one or one-to-many. There is also a check box that enables you to specify whether the relationship
is an identifying relationship.

7.7.2.3. Connection Properties

Right-click a connection to select it. When a connection is selected, it is highlighted and its properties are
displayed in the properties palette. Connection properties are quite different from the properties of other
objects. The following list describes them:

e capt i on: The name of the connection. By default, the name is the name of the foreign key and the
property is centered above the connection line.

e captionXO fs: The X offset of the caption.
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captionYO f s: The Y offset of the caption.

comment : The comment associated with the relationship.

dr awSpl i t : Whether to show the relationship as a continuous line.
endCapt i onXOf f s: The X termination point of the caption offset.
endCapti onYOF f s: The Y termination point of the caption offset.

ext raCapti on: A secondary caption. By default, this extra caption is centered beneath the connection
line.

extraCapti onXOf f s: The X offset of the secondary caption.
ext raCapti onYO f s: The Y offset of the secondary caption.

mandat or y: Whether the entities are mandatory. For more information, see Section 7.7.2.2, “The
Relationship Editor”.

many: False if the relationship is a one-to-one relationship.
m ddl eSegnent O f set : The offset of the middle section of the connector.

nodel Onl y: Set when the connection will not be propagated to the DDL. It is just a logical connection
drawn on a diagram. This is used, for example, when drawing My| SAMtables with a visual relationship,
but with no foreign keys.

nane: The name used to identify the connection on the EER Diagram canvas. Note that this is not the
name of the foreign key.

ref err ediVandat or y: Whether the referred entity is mandatory.
start Capti onXOf f s: The start of the X offset of the caption.

start Capti onYOr f s: The start of the Y offset of the caption.

In most cases, you can change the properties of a relationship using the relationship editor rather than the
Properti es palette.

If you make a relationship invisible by hiding it using the relationship editor's Visibility Settings, and then
close the relationship editor, you will no longer be able to select the relationship to bring up its relationship
editor. To make the relationship visible again, you must expand the table object relating to the relationship
in the Layers palette and select the relationship object. To edit the selected object, right-click it, then select
Edit Object. You can then set the Visibility Settings to Fully Visible. The relationship will then be visible
in the EER Diagram window.

7.7.3. Creating Views

You can add views to a database either from the Physi cal Schenat a section of the MySQL NMbdel
page or from the EER Diagram.

7.7.3.1. Adding Views to the Physical Schemata

To add a view, double-clicking the Add Vi ewicon in the Physi cal Schenat a section of the My SQL
Mbdel page. The default name of the view is vi ewl. If a view with this name already exists, the new view
is named vi ew2.
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Adding a new view automatically opens the view editor docked at the bottom of the application. For
information about using the view editor, see Section 7.7.3.3, “The View Editor”.

Right-clicking a view opens a pop-up menu with the following items:
e Cut'vi ew _nane'

As of MySQL Workbench 5.2.45, the 'vi ew_nane' is only cut from the EER canvas. Before, it was also
removed from the schema.

» Copy 'vi ew_nane’

» Paste

» Edit View...

+ Editin New Window...

» Copy SQL to Clipboard

» Delete 'vi ew_nane'": deletes from both the EER canvas and schema.

* Remove 'vi ew_nane': deletes from the EER canvas, but not the schema.
This option exists as of MySQL Workbench 5.2.45.

If the table editor is not open, the Edit View... ite